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1. BASIC 
 
The core of the SOFiSTiK program is a very efficient data base (CDBASE). The Group of 
programs is able to solve different problems from structural analysis to  interchange data 
through the data base. 
 
SOFiSTiK consists of a large number of modules which communicate with each other either 
trough standard text files or through graphical interfaces. CADINP is a powerful command 
language. It allows full operation of the possibilities of certain modules in the analysis. 
Experienced programmers use flexible CADINP macros to simplify the data input, especially 
when entering complex systems. 
 
SOFiPLUS is a graphic preprocessor which is used to create the structure. With its help, 
AutoCAD drawings and DXF files are converted into structural elements. The program is 
based on AutoCAD. The contours of the structure is drawn with the AutoCAD commands. A 
great number of functions easily permit to convert the basic AutoCAD entities in structural 
elements and loads. As a preprocessor, SOFiPLUS creates the input file, which is later used 
by the adequate SOFiSTiK modules for structural analysis. Therefore SOFiPLUS is the right 
product for any user, who wants to use the functionality of the SOFiSTiK analysis programs in 
conjunction with AutoCAD.   
 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pic.  1   SOFiSTiK Organization chart  
 

1.1 WORKING DIRECTORY 
 
For practical purposes it is recommended to save any data from a project in one working 
directory. It is eligible to create a directory with the same name as the project name. The user 
should create such a folder before drawing the first drawing. This directory will then contain 
the necessary drawings and data for the analysis of the structure.   
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1.2 DRAWING NAME 
 
The drawing name should contain the necessary information to identify the drawing without 
having to view it. The project number, position or index may be used as recognized attributes 
from the drawing file name.   
 
Example: 8901A105a.dwg 
 
project number 
A  name of structure to be analyzed  
a  index  “a” 
.dwg  file extension (AutoCAD file) 
 
 

1.3 LAYERS 
 
Objects created with SOFiSTiK have properties: layer, color and line type. Layers are 
construction plans on which objects are systematically grouped with different drawing 
information. Some layers are created during the work with SOFiPLUS. For example the 
program SOFiPLUS puts any nodes on the layer X__KNOT_database name. 
User can control visibility and access for object modifications placed on a layer. It is advisable 
when drawing the structure, to pay attention in grouping the construction elements on 
different layers. This is a particular practice for complex structures when structural elements 
from different types overlap. Systematical grouping allows easier object selection or their 
conversion into structural elements.  
 
 

1.4 AUTOMATIC SAVING 
 
Creation and analysis may take some time. It is advisable to pre-select the time interval for 
automatic data save. If for any reason the operating system or AutoCAD crashes, only the 
changes in drawings and database after the last saving interval are lost. The AutoCAD 
command Preferences allows you to adjust the time interval for automatic data save. The 
automatic save is made to the file name defined in AutoCAD → Preferences. If continuing 
working with the automatically saved file is desired, thes file must be renamed.  
 
 

1.5 BASIC ANALYSIS STEPS 
 
Create working directory  
Start AutoCAD 
Open existing drawing (“Open” command) or start the work with new drawing (“New” 
command) and select “Metric” for units. 
Define structural system. Make a connection between structural system and database.  
Use AutoCAD commands to draw geometry of the structure.  
Define materials used in the structure. Materials are automatically saved into database. 
Create cross sections for the structural elements. Cross sections are automatically saved into 
database.  
Use SOFiPLUS commands “Generate elements” or “Modify elements” to convert graphical 
entities in structural elements. 
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Define the element and node loads.  
Export the structure and loads into the database. (“Export” command) 
Start the analysis.  
Display the results on the screen or print them in numerical or graphical form.  
 

1.6 STRUCTURAL SYSTEM 
 
The structural system may be created for a small part or for the whole mathematical model of 
the structure. For example, our usual practice is to examine three dimensional frame systems 
as separate two dimensional frames. In such approximation, every plane frame represents a 
specific structural system, which is molded and analyzed independently. On the other hand, 
SOFiSTiK - with its efficient tools for modeling and analyzing - allows more realistic structure 
representation, treating it as three dimensional frame structure.  
Structural system… allows inputting database and connecting it to the structural model. 
During analysis, the database remains open. Several data (materials and cross sections) are 
entered directly into the database, while the rest data must be explicitly exported into the 
database. 
Coordinate system and standards for the analysis are defined only once and cannot be 
modified later. At the system selection, some predefined (default) materials are automatically 
entered into the database. Those materials can be modified with simple commands in the 
next analysis steps. 
 
 
 

 

ICON : SOFiPLUS 
 MENU: SOFiPLUS→Structural system… 
Command: SOF_GSYSMOD 

 

Important: If you make changes in the structural model with commands which are not in the 
SOFiPLUS pull down menu or with usual AutoCAD commands, re-exportation of the database 
must be performed in order to introduce the changes into the analysis.  

 
After the command Structural system… a dialogue box pops up which connects project to the 
database. 
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Project:  Header line. All results have the same name as project name in the header 
line. 
 
Database: Database name. Maximum 24 characters. Extension name .CDB is assigned 
automatically. Default name is drawing file name.  
 
Orientation of Self Weight: 
 
 Orientation of the self weight.  
 
Design Code:  Choose a standard for the analysis.  
  
 Ephemeral embedded standards in SOFiSTiK are: 
 
ACI  American  
BS  British 
DIN  German   
EC  Euro codes 
OENorm Austrian 
SIA  Swiss 
 
Maximum elements of numbers per group: 
 
 For easier parameter control for dimensioning, elements must be divided in groups. 
By this input, the maximum element number is determined which may belong to a group. This 
value has no influence on the maximal area elements number. Elements from a structural 
area belong to one group. 
  
Point size: This control determines the size of the displayed nodes and points in the 
structure. The text in the structural areas and holes as well as scaling the line types depends 
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on the entered value in Point size. Practically, this control determines the legibility of the 
drawing on the screen.  
 
Highest node No.:  
 
  Shows the biggest number created by the program. 
 
Groups on separate layers:  
 
If you select this option, every group of elements is placed into separate layers. 
 
Structural model:  
 
Choose a structural model. Three options are available: 
 
Space; 
Frame/Wall; 
Girder/Slab. 
 
Analysis type:   
 
For plane problems four subsystems are defined: 
frame system (No system), Plane stress state, Plane strain state) and Axial symmetry state. 
 
Data base coordinate system:   
 
Choose one from the three suggested coordinate systems: 
SOFiSTiK, World and UCS. SOFiSTiK coordinate system differs from AutoCAD World 
coordinate system in the direction of Z-axis. In World coordinate system Z-axis is directed 
towards users eye (right hand rule) while SOFiSTiK Z-axis has inverse direction. 
 
Drawing units:   
 
 Select drawing units. 
 
Output units:  
 
 Determine output units which will be used at dimensioning. 
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Settings:  New dialogue window opens to set basic SOFiPLUS parameters. 
 

 
 
 
Example 1: Triangular truss with following geometry: 
 

 
 
Material: Wood 
Truss distance: 2.5 m 
Loads: 
 

1. Double layers of waterproof paper over wood planks 400 N/m2  
 2. Snow on horizontal surface     750 N/m2 
 3. Wind perpendicular to inclined surface   240 N/m2  
 
 
 
First, create working directory RESETKA to input the database, drawing and all additional 
files produced in the analysis. Draw truss geometry in AutoCAD. If you draw dimensions for 
the truss and additional texts it is advisable to place them in separate layers. To increase the 
visibility turn off all unnecessary layers from the view area. Define the database and connect it 
with the structural system. 
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ICON : SOFiPLUS 
 MENU: SOFiPLUS→Structural system… 
Command: SOF_GSYSMOD 

 
 
Fill / select working parameters according to enclosed picture: 
 
 
 
Project Resetka 
Database 1521R101 
Orientation of Self Weight: Pos. Y axis 
Design Code EC 
Max. num. of elem. per group 1000 
Point size 0.05 
Structural model Frame/Wall 
Group on separate layer √ 
Data base coordinate system SOFiSTiK 
Drawing units m 
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1.7 MATERIAL 
 

 
ICON : Material 
 MENU: SOFiPLUS→Defined model→Material 
Command: SOF_GSYMATE 

 
Dialogue box displays on the screen with several default materials. 
 

 
 
Delete or Modify unnecessary materials shown in the list. In this example default materials 
are: concrete (C20), standard reinforcement (S 235), prestressed reinforcement (S 500)  and 
masonry (MZ4I). Delete any materials (first select the material to delete and click on Delete 
button). Because Wood is not in the list, it should be imported in the list by clicking on the 
New button. New dialogue box pops up on the screen. 
 

 
 
Select (EC 5) from the Type list for Standard Timber C. The described procedure is common 
to select standard materials, defined in implemented standards in SOFiSTiK. Review and 
modification of specific selected materials can be accomplished with the buttons shown on 
the right of the dialogue box. With this buttons nonstandard materials can be added i.e. 
materials which are used in standards not implemented in SOFiSTiK. 
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The modification procedure of the material is almost the same as the procedure for adding 
new material. First you should select the material and then click on the Modify button. The 
same dialogue box appears where you should select proper material and classification. 
 
 

1.8 CROSS SECTION 
 
Before creating the structural model it is desirable to define any cross sections which are 
used in the model. As far as changes in the following analysis steps are necessary, you can 
define cross sections afterwards.  
 

 

ICON : Cross Section 
 MENU: SOFiPLUS→Defined model→Cross Section 
Command: SOF_GQUER 

 
By activating this command, dialogue box Cross Section appears. 
 

 
 
In the beginning the list is empty. You can add new cross section with the New button. 
SOFiSTiK allows simple creation of standard sections implied in national codes of many 
countries.  
 

 
 
You can select one from the eight offered standard sections. 
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Cross-section-value. Direct input of section geometric properties   
Plate-Reinforced concrete slabs 
Rectangle-Rectangular cross sections 
T-Beam section  
Circle / annual section  
Cable section  
Rolled steel  
 
In this example any element has a rectangular section. Select Rectangle from the list and 
dialogue box pops up to enter cross section values. 
 
 

 
 
Material: If a project consists of several materials, select the material for the examined 
cross section.  
Height [m]: Enter section height in meters. 
Width [m] : Enter section width in meters. 
 
Following combo boxes allow entering torsion moment of inertia, effective shear width in 
vertical and horizontal direction i.e. proper reduction factors which are applied for appropriate 
geometric properties. In this example, axial stressed structure is examined, so these values 
have no influence in the analysis.   
 
Position of origin:  Combo box which determines section coordinate system which is 
used to place the section in the structure.  
Reinforcement: Visual tools used to input necessary parameters for the reinforcement. In this 
example, they are not active because the structure is made from timber. 
Section title: Name of the section. SOFiSTiK declares default name for the section. In the 
name height and width is contained. User can change section name and rename it to a title 
which is easily recognized in the following analysis steps. 
 
Following the procedure described for section 1, enter values for the rest cross sections.  
 
Section  H B 
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1  0.20 0.14 
2  0.18 0.14 
3  0.10 0.14 
4        0.10 4.8=2*2.4 
 
 

1.9 CREATE FINITE ELEMENTS 
 
SOFiSTiK is a very flexible program. Often, several approaches are offered to model the 
structure. You should select the right one depending on the situation and adjust it according 
to your work style. At this point you have access to a large number of AutoCAD functions, 
which allow full control over visibility, positioning, selection, copying and modification of 
objects in the structure. 
 
In this example, in the truss only one element type is used - truss finite element. Two methods 
for creation of truss elements are presented. 
First method is activated by: 
 

 

ICON : Truss element 
MENU: SOFiPLUS→Create finite element→Truss element 
Command: SOF_GFACH 

 
Successive input of element start point (NA) and end point (NB) starts. It is possible to pick a 
point directly from the screen (use AutoCAD tools for precise positioning)  

 
 
or enter coordinates directly from the command line: 
Node NA (end+cen+nod+int+ext): 0,0, 0.0 
Node NE (end+cen+nod+int+ext): 2.5, 0.0 
Input schedule has influence. Local element axis starts in point NA and is directed to NB. 
Beside end point coordinates number of the cross section should be entered i.e. prestressing 
force, as far as it exists. 
Section number<1> or [Prestress force]: 2 
If section is not already defined in the command line following message appears: 
+++ WARNING: Cross section not defined! 
Cross section may be defined later. 

 
Command: SOF_GFACH 
Node NA (end+cen+nod+int+ext): Pick point NA 
Node NE (end+cen+nod+int+ext): Pick point NB 
Section number<1> or [Prestress force]: 2 
 
+++ WARNING: Cross section not defined! 
First Truss beam No.<1>: 1 
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Node NA (end+cen+nod+int+ext): Pick point NA 
Node NE (end+cen+nod+int+ext): Pick point NB 
Section number<2> or [Prestress force]: Return 
 
+++ WARNING: Cross section not defined! 

Node NA (end+cen+nod+int+ext): Pick point NA 
Node NE (end+cen+nod+int+ext): Pick point NB 
Section number<1> or [Prestress force]: Return 
 
………………………… Enter all truss elements 
 
As presented before, this method for creating truss finite elements does not allows to group 
elements. Entering element groups is done by modifying commands. 
 
A more efficient method for creating structural elements is achieved using the command 
Generate. It allows simultaneous input of several elements with same properties. Also, with 
this command element groups are entered directly. 
 
SOFiPLUS→Generate→With objects 
 
Select Truss option in the dialogue box: 
 

 
 
Minimum edge length [m]: 
 
is filled with slab structures in order to specify minimum slab edge length 
  
Group No.:  
 
Enter group number which identifies the element. This value is multiplied with maximum 
element group number previously defined with general structure parameters (the command 
Structural System…) and the result is the start number of elements in the group. For example, 
if with the command Structural system… maximum element number is defined as 1000 and in 
the edit box Group No. value 2 is entered, then start number of the group has value 2000 
(2⋅1000). In this example, our structure is simple and there are no element grouping, so  
group number is as default 0. 
 
Break entities on intersection:  
 
Define the method for treating the element intersection points. If this option is turned on then 
new point is inserted on the element section and elements are divide in two separate 
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elements. When this option is not active, elements are divergent. New point is not inserted 
and original elements remain unchanged. 

 
 
 
√ Break entities on intersection  
 
Break entities on intersection  
 
Perform selection on all objects (lines) which should be converted in truss elements. 
 
Select objects: 
 

 
In relation to the option Break entities on intersection, a search for intersection lines is carried 
out and new points and elements are defined. 

 
Searching intersections .... 
 

Treating partial-lines ... 
Making Elements ... 
 
After this, enter the number of cross section for the input element group. 
 
Section number<2> or [Prestress force]: 3 
  
In dependence on number of already created elements and number of element group which 
are formed, SOFiSTiK offers first number of selected elements. 
 
First Truss beam No.<9>: 
 
You may accept the offered number or may enter a number which is not previously used. 
 
 

1.10 SUPPORTS 
 
When you create structural elements, at the end of the elements i.e. their intersection points 
are automatically defined as node points. These nodes are free by default and displacements 
are able to occur on any system degrees of freedom. Actually, supports are bonds which 
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restrain certain displacements. They are entered in the structure with the command Modify 
Nodes, which restrains displacements in determined directions.  
 
 

 

ICON : Modify node 
 MENU: SOFiPLUS→Modify finite element→Node 
Command: SOF_GNOTMOD 

 
Select node points which have to be constrained in defined degrees of freedom.  
 
Command: 
Select option <Select objects>[Select objects/Enter number/Pick nodes]: p 
 
Three ways to select supporting nodes are possible: by selecting the object (in this example 
node point), by entering the node point and by picking the node point. In this case the third 
way is chosen by picking the node point. 
 
Nodes (end+cen+nod+int+ext):  Pick point P1 
Nodes (end+cen+nod+int+ext): Pick point P1 
 
Pick the end points on the truss (P1 and P2). 
 

 

 

 
 
After choosing the appropriate points to represent supports, a dialogue box pops up on the 
screen where you should click to enter the proper displacements. 
 
 
 

 
This dialogue box shows the number of selected node points (2 selected). By clicking on the 
button Add you return in the position to select new points to represent supports. Similarly with 
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the button Remove again you return in the position to select points, but the preferred points 
are deleted from the selected group.    
In the current example, check the Px and Py boxes. This is to sign reactions in X and Y 
direction to selected node points, so you create fixed supports. 
If you select only one node, Edit single node boxes are active. With them you are able to 
change node number as well as its position. 
 
 
 

1.11 Info / Edit 
 
 
INFO/EDIT is powerful tool to use with the purpose of viewing the main properties of 
structural elements with the opportunity to change them. For example, displacement in given 
direction can be constrained by using the INFO/EDIT command. 
 
 

 
ICON : Info/Edit 
 MENU: SOFiPLUS→Info/Edit… 
Command: SOF_G????? 

 
 
Select the structural element you want to review or make a change in the properties. In this 
example, end left node of the truss is selected (node which has to act as fixed support). On 
the screen dialogue box is called up, where information for the selected element are shown. If 
the selected element belongs to few structural elements, only information for one element is 
shown. 
 
 
 
 

 
 
With the button New you are able to show information about the next element which has 
mutual point with the selected. By moving forward (Next) or backward (Previous) the element 
which you are about to change is displayed. In the current example it is node point. 
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Click on the button Modify to begin with entering the changes in the element whose properties 
are presented on the screen. 
 

 
 
Mark the PX and PY check boxes to indicate that a point can accept reaction forces in X and 
Y direction. By clicking on the Ok button you continue with the selection of the next element 
which has to be changed. The following element may be truss element for which we want to 
display the data or to make a modification. 
 

 
 



 
 
 

 
1—23        SOFiPLUS_Tutorial_IGH.docf 

In this case everything is clear. Only one element connected with the selected object exists, 
so in the dialogue box buttons Next and Previous are disabled. Dialogue box called up by 
clicking on the Modify button allows entering the modifications of the selected truss element. 
 

 
 
The button Cross section starts the dialogue box which contains the list of defined cross 
sections. 
 

 
By choosing one of the sections presented in the list, modification in the element cross 
section is executed. 
Beside element modification, change in the group for the element can be done or appropriate 
prestressed force can be applied on the element. 
With the objects in the dialogue box, placed in Edit single element frame, you can make a 
change in the element ordinal number (Element No.) or in the numbers of its member nodes 
(Node 1, Node 2).  
  
 

1.12 SUPPORT VISUALIZATION 
 (DISPLAY RESTRAINTS) 
 
To display the supports in the structure their visualization in necessary to perform.  Select the 
function Display restraints from the visualization menu.  
 

 

ICON : Display restraints 
MENU: SOFiPLUS→Visualize→Restraint 
Command: SOF_GFEST 
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On the question: 
 
 Einstellungen? [Ja/<Nein>]: J 
 
answer with J if you have to make change in the element size and color. 
 

 
 
Choose new color and enter the symbol size to represent structure supports. 

 
 
In case supports in the following steps entirely cover the drawing, to obtain better preview on 
the situation, you can hide them from the screen view port. 
The command: 
 
SOFiPLUS→Visualize→Delete visualization 
 
starts the following dialogue box: 
 

 
 
Check the Support condition check box and select the Switch off option to make the supports 
invisible. This action has influence only on supports visibility, so they are present in the 
structure and constrain the applied deformations. The same effects can be achieved using 
layers. 
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Supports are drawn in the layer XV__FEST_TRUSS (project name). By turning this layer off, 
supports are not displayed on the drawing. 
 
 

1.13 LOADS 
 
Before loading the structure, it is necessary to define all load cases. 
 

 
ICON : Loadcase Manager 
MENU: SOFiPLUS→Loadcase Manager 
Command: SOF_GLFMOD 

 
At the beginning the load case list is empty. With the button New, new load case is entered in 
the list. The list profile i.e. number of combinations depends on the implemented standards 
used for dimensioning the structure. First few attributes are common. Combinations and load 
factors are different for DIN and EC. 
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N  Number of load case 
 
Description Few words to describe the load case  
 
Kind of Load It can be general, additional and special. Every national standard performs 
load classification and determines the group which load belongs.  
 
Type of load Larger load classification is presented to define load combinations.  
 

 
 
If self weight of structural elements is needed for particular load case then you should enter 
the proper factor SW (Self Weight). For instance, SW factor 1.00 means that the self weight of 
the elements is fully taken in determination of the loads for that load case. 
For this example, three load cases are defined. They are shown in the Loadcase Manager 
dialogue box.  
Before entering the loads for certain load case, it should be appointed as current. For 
example, to input loads in the SNEG load case, select it from the list and click on the Current 
button. 
Loads are entered in the following steps which belong to SNEG load case. 
For this example, first enter loads in the Stalni tovari load case to represent dead loads. Make 
Stalni tovari load case current. Load from the roof acts as uniformly distributed load along the 
length of the upper chord. Load direction is positive Y-axis direction. To enter this load use 
the following options: 
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ICON : Truss element load 
MENU: SOFiPLUS→Create loads→Truss element loads 
Command: SOF_GXLAS 

 
Command: SOF_GXLAS 
Trusses to be loaded 
Select objects: select elements from the upper chord 

 
Select objects: Return  to finish selection 
 
Load type and direction [PX/PY/PXP/PYP/ES/TS/VS]: py 
Load value in kN/m: 1 
Trusses to be loaded 
Select objects: Return  to finish load input 
 
PY Load acts along the whole element length in global Y-axis direction. 
 
In the bottom at the center of the truss, a load with weight 2 kN is hanged up. This load acts 
directly in truss node. Entering loads from this type is done by: 

 

 

ICON : Node Load 
MENU: SOFiPLUS→Create loads→Node Loads 
Command: SOF_GKLAS 

 
Command: SOF_GKLAS 
Nodes to be loaded 
<Select object>[ Select object /Enter number/Pick nodes]: P 

 
Select the node by clicking directly on the node where force acts. 
 

Nodes (end+mit+pkt+lot+ext):  click on the point P1 
Nodes (end+mit+pkt+lot+ext):  RETURN 

 
 

 
Load type [Load/Moment/Displacement/Rotation]: L 
L load type, concentrated force  
 
Direction of effect [PX/PY/Zeigen]: PY 
PY load direction, positive Y-axis direction  
 
Load PY in kN: 2 force value  
Nodes to be loaded 



 
 
 

 
1—28        SOFiPLUS_Tutorial_IGH.docf 

<Select object>[Select object/Enter number/Pick nodes]: RETURN 
 

Input loads are displayed on the screen. 
 

 
 
 
Before entering the loads for the next load case it is recommended to disburden the drawing 
with the loads from the previous load cases. SOFiPLUS creates separate layers for every 
load case. 
 
 XV__K???_database name, and 
 XV__X???_ database name 
 
K    label for node loads  
X   label for distributed loads  
???   number of load case  
database name  name of the analysis database  
 
For the current load case create the following layers: 
 
 XV__K001_TRUSS, and 
 XV__X001_TRUSS 
 
Make these load cases invisible with the AutoCAD function Layer Property Manager, by 
switching off the appropriate layer. 
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SOFiPLUS has its own command which allows turning off certain load cases from the view 
area. 
 
SOFiPLUS→Visualize→Delete visualization 
 
Select &Loads and Switch Off 
 

 
 
to turn off all load cases from the view area. 
In the next step in Loadcase Manager put load case Sneg as current. With this action entering 
loads for the load case begins. Snow is proposed as uniformly distributed load which acts on 
single unit on horizontal area. For this truss snow acts on upper chord along the horizontal 
element projection. 
 

 
ICON : Truss element load 
MENU: SOFiPLUS→Create loads→Truss element loads 
Command: SOF_GXLAS 

 
 
 
Command: SOF_GXLAS 
Trusses to be loaded 
Select objects: select elements from upper chord  
 

 
Select objects: Return  to finish the selection 
 
Load type and direction [PX/PY/PXP/PYP/ES/TS/VS]: PYP 
PYP The load acts along the element projection in global Y-axis 
 
Load value in kN/m: 1.875 
Trusses to be loaded 
Select objects: Return  to finish the selection 
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ICON : Truss element load 
MENU: SOFiPLUS→Create loads→Truss element loads 
Command: SOF_GXLAS 

At the end in Loadcase Manager make load case Wind as current and start entering loads for 
this load case. Wind is set as uniformly distributed with intensity of 0.6 kN/m2 (240 N⋅2.5 m) 
acting perpendicularly on the upper chord of the truss. The projection of this load is 
determined in direction of X-axis (0.582 kN/m2) and Y-axis (0.145 kN/m2) and this load is 
applied on upper truss elements.  
 

 
Command: SOF_GXLAS 
Trusses to be loaded 
Select objects: select elements from upper chord 
 

 
 
 
Load type and direction [PX/PY/PXP/PYP/ES/TS/VS]: PY 
Load value in kN/m: 0.582 
 
Trusses to be loaded 
Select objects: select elements from the left part (P1-P4) 
Load type and direction [PX/PY/PXP/PYP/ES/TS/VS]: PX 
Load value in kN/m: 0.145 
Trusses to be loaded 
 
Select objects: select elements from the right part (P5-P8) 
Load type and direction [PX/PY/PXP/PYP/ES/TS/VS]: PX 
Load value in kN/m: -0.145 
Trusses to be loaded 
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1.14 LOAD MODIFICATION 
 
Sometimes it is necessary to make changes in the applied loads. Changes can be done in the 
size and direction of the loads, but also load can be moved or copied in other load case.   
 
 

1.15 MODIFICATION OF NODE LOADS 
 

 
ICON : Modify Node Load 
MENU: SOFiPLUS→Modify loads→Node  
Command: SOF_GKLASMOD 

 
Determine a way to select the nodes in which load is modified. 
 
<select object>[Select object/Enter number/Pick nodes} 
 
Select object  select more nodes using AutoCAD methods for selection Box and 

Window crosses. 
Enter number  enter node number   
Pick nodes click on the node  
 
A dialogue box opens where values for selected loads are shown. You can add new nodes to 
change the load, modify the load value or move the load in other load case.  
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Add/Remove adding/removing new nodes to modify the load  
 
Load values load values (Loads/Moments) or displacements (Displ/Rotation) are 

modified 
 
Loadcase   select the load case to move the load  
 
Actual    displays the load which contains the force  
 
 
 

1.16 MODIFICATION OF ELEMENT LOADS 
 

 
ICON : Modify Truss Element Load 
MENU: SOFiPLUS→Modify loads→Truss  
Command: SOF_GXLASMOD 

 
The procedure is exactly the same as at node loads modification. The difference is only in the 
dialogue box which at this moment contains necessary blocks for modification of distributed 
loads. 
 

 
 
 
 
 

1.17 DATABASE EXPORT 
 
Whenever elements to be modified are selected, or when warnings and errors are expected 
during data control, appropriate elements are marked. 
 

 
ICON : VIZUALIZE→Toggle Display Mode … 
MENU: SOFiPLUS→Markers→S-Toggle Mode 
Command: SOF_GERROR 

 
Labeling can be permanent or temporary. 
 



 
 
 

 
1—33        SOFiPLUS_Tutorial_IGH.docf 

Command: SOF_gerror 
++ HINT: Element marking permanently installed 
Command: SOF_gerror 
++ HINT: Element marking temporarily installed 

 
Temporary making is deleted at next zoom or Redraw. Permanent deletion can only be done 
with the command Erase Layer or Erase Error Marking. 

 

 
ICON : VIZUALIZE →Export 
MENU: SOFiPLUS→Markers→Erase Error Marking 
Command: SOF_GDELERROR 

 
Before exporting the database you should make permanent marking of elements. (Element 
marking permanently installed). This way is much easier for the purpose of discovering 
elements which contain warnings and errors. 
When you create the whole structure and when all load cases are entered, data should be 
saved in analysis database. 

 

 

ICON : SOFiPLUS→Export 
MENU: SOFiPLUS→Analysis Data Base (CDB)→Export(..  
Command: SOF_GENFOUT 

 
The command Export transfers all data placed on the drawing into analysis database.  

 
 
There is possibility to create output (ASCII) file or to perform structure control without creation 
of output file.  
 
Data base .CDB – database is generated which contains all information about the system 
and the loads. Load cases are saved in text file (databasename.LF). Control is fulfilled in 
order to notice possible errors. By performing this command, few files are created: 
 

• Databasename.CDB – database created by the program; 
• Databasename.DWF – drawing with structural system and loads; 
• Databasename.DAT – file used at calculation start; 
• Databasename.ERG – program generates resultant file GENEF; 
• Databasename.LF – input file which contains load factors; 
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• Databasename.MSH – input file for the program SOFiMESH. 
 
The load factors file (Databasename.LF) can be used directly in the static calculations. 
 
ASCII files. SYS and LF.  Output system information and applied loads are saved in text file 
(ASCII). This command creates following output files: 
 

• Databasename.CDB – database created by the program; 
• Databasename.DWF – drawing with structural system and loads; 
• Databasename.DAT – file used at calculation start; 
• Databasename.LF – input file which contains load factors; 
•  

Databasename.SYS - input file for the program GENEF. 
 
Check run (no output).  Data are checked for possible errors. Few mechanisms for data 
control are implemented. For example, nodes deleted by mistake and connected with the 
elements, are recovered or two nodes which are contained in one point are connected and 
etc. 
 
 
Range of export. Controls which data will be exported. System, individual or all load cases. 
The Print and optimize button controls the output file .LST and performs optimization of the 
width in the system stiffness matrix band. Because this process consumes plenty of system 
time, this option has sense to execute it at the end of the calculation.  
 
Output for program. Defines for which program module data are exported. Pre-selected is 
the module that depends on the structural system (STAR2/3-Frame, SEPP-Slab/Plate, ASE-
Space). 
 
Mark node with distance <=… from each other. All nodes on a distance smaller than 
specified are marked. 
 
Correct without prompt. Defines if correction of errors will be automatic or for the 
modification program should ask for a verification. 
 
Correct without screen marking. Controls if check is accomplished with marking the correct 
elements. 
 
Page numbers. Allows entering number for the first page. Numbers of the resultant file are 
increasing starting from the entered number. If numeration of pages is not necessary, disable 
this option. 
 
Data bases available. Amount data base list connected to the drawing. Selection of the 
database is executed by double clicking on the name from the list. 
 
Output-file. Enter the output file name. 
 
Select output file… Standard Windows dialogue box is called up to select the output file. 
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1.18 ANALYSIS 
 
Analysis is performed with the program WTEDY. 
 

 
ICON : Edit (Win Ted) 
MENU: SOFiPLUS→Analysis … 
Command: SOF_G 

 
At start of this module a dialogue box is called where you should enter input data base name 
(databasename.DAT), which is created while exporting the data. 

 
 
In this example it is TRUSS.DAT file. After the file selection, you are able to enter working 
environment of the WTED program. The program disposes of large number of functions which 
control the calculation and make selection and way of displaying the results. By its activation, 
input file is loaded in the editor. You can modify this file additionally in order to turn on 
operations which are not implied by default options or change some parameters in default 
options.  
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From the input file it is obvious that calculation activates several program modules: AQUA, 
ATAR2, GRAF, MAXIMA, AQB and END. The list of default program modules depends on the 
chosen structural model. It can be extended, but some modules not in use can be removed. 
For this example, you can remove MAXIMA, that determines the enveloping of maximal and 
minimal values as a result from load combinations. You should have some experience with 
these modules in order to make corrections in them. In the current example, you will make 
change in the second module GRAF. By default this module shows results only from the first 
load case (LC 1). Beside that, by default this module shows transversal forces, axial forces 
and moment on beam elements (BEAM VZ, BEAM MY, BEAM N). Because this example 
deals with truss structure, they are omitted, so their place takes: 
 
  LC 1 

BEAM N STYP TRUS               $ 
LC 2 
BEAM N STYP TRUS               $ 
LC 3 
BEAM N STYP TRUS               $ 
 

In the graphic output file results for axial forces from three load cases are shown.  
Program AQB by default calculates stresses in the system. 
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In the list of modules: 
 

 
 

sign “+” denotes that module is included in the calculation. By clicking on it, module sign 
converts to “-“ which indicates that the module is not taken in the calculation. Thus, user is 
able to control programs which participate in the calculation. Three icons start the calculation 
process: 
 

 
Starts the module WinPS that allows control over the calculation process 

 
 

 
Starts directly the calculation. All modules with “+” sign are taken into the 
computation. 

 
Only module where cursor is positioned is executed. 
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2. WORKING WITH THE ANIMATOR 
 
Animator is usually used for visual control of the structure and output results. It can be started 
from AutoCAD using the SOFiPLUS Tools. 

 
 
or from WinTeddy working environment.  
 

 
 
Animator starts a graphical window where structure is shown. 
 
 

 
 
By simply dragging the picture (click on left mouse button, hold down the button and move 
around within the window) you can shift the view point of the structure. 
The following tools: 
 

 
 
enable different structure views. 
  

 horizontal projection 
 vertical projection in Y-Z plane 

 vertical projection in X-Z plane 

 perspective view 
 
In case certain parts of the structure have to be displayed in larger scale, following tool may 
be used:  

 zoom to point, 
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with whom part of the structure which has to be displayed in larger scale is pointed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Effect from this action are shown bellow. 
 

 
 
Next two tools are classical AutoCAD tools, 
 

  zoom window and zoom extend.  
 
Their usage is well known to every AutoCAD user and therefore they will not be explained. 
 
Next tool 

  Element info 
 
allows obtaining information about geometry i.e. forces in certain element. 
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Dialogue box pops up on the screen asking to point the element i.e. support which detail 
information are needed. 
Displayed results depend on momentary selected option. 
Tool,  

 Choose loadcase 
 
allows displaying the structure and deformed shape of the structure in separate load cases. 

 
If you select a load case, for example LF 1 Stalen tovar, with the slider Speed Displ. 
0=steady, you are able to regulate animation speed i.e. displacement of the structure at load 
case Stalen tovar. With slider Magnitude deformation magnitude can be changed while with 
slider Speed Rotate animation is proceeded by rotation of the structure.  
 

 
If slider Speed Dipl. 0=steady, is placed in initial position or icon 
is clicked, then deformed shape of the structure is shown including legend where 
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stress changes of the structural elements are presented in different colors with their maximal 
values. 
 

 
 
The tool 

 Next loadcase 
 
displays animation for the next load case. 
 

 
 
While running the animation detail information for certain structural elements can be acquired. 
For this purpose it is necessary to activate the tool 

 Element info 
 
On the screen and in the additional window selected element information are shown. 
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The next group of tools 
 

 
 
have influence on the way to display the structure. Some of them work with toggle mode. With 
one click they are turned on and with the next they are turned off.  
 

 View support 
symbols Supports are shown in larger or smaller scale size 

 View separation 
lines Finite element mesh is shown  

 View cross sections Structural lines are shown by one line or in true size 

 View coordinate-
systems 

Local coordinate systems are for structural elements are 
displayed  

 Colored result  
Off/On 

Elements are shown in different colors depending stresses 
inside them  

 Colored result 
1/2/3=relative/... Way to display stresses at nonlinear analysis  

 
Group + box 
selection Displaying different groups  

 Shoot one group 
[except=deselect] Switching off certain element groups from the view port  
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3. WORKING WITH WinGRAF 
 
WinGraf is a module for graphical presentation of the structure and results. With help of 
WinGraf module, a drawing book is created. Three drawing categories are available: 
structural system, loads and results. You can start the program from the SOFiPLUS menu in 
AutoCAD or from WinTedy module. 
 

 

ICON: WinGraf 
MENU: SOFiPLUS→Graphical output→Graphical output… Command:  

 
The operating environment of the program is shown in the following picture. 
 

 
 
The central part of the screen is occupied by the graphical display where by assumption, 
drawn structure is shown. With this action, the first page from the drawing book is entered 
automatically. Program has a large number of functions for controlling the manner of showing 
graphical elements from the drawing. 
First, you should determine drawing format. The routine is similar to standard Windows 
applications.  
 
 File→Page Setup 
 
A dialogue box is called up on the screen that allows selection of the format, borders and 
drawing orientation. The same effect can be attained by double clicking with the mouse on the 
tab you want to modify, in the right part of the screen in the operating environment Layer. (in 
the example Page 1). 
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In the Annotation tab you can adjust text properties and select the language you will use for 
displaying the results as well as the basic color during the drawing. 
 

 
 
Regarding the current example, paper format is A4 an orientation is Portrait. The rest 
parameters are as default. 
Commonly one drawing is placed on one page. For this example, three structure drawings are 
placed on the first page. The first is with nodes, the second with element numbers and the 
third is with labels for cross sections of the elements. You can change the size and layout of 
the drawings on several ways. By double clicking on the drawing, you mark the drawing and 
eight red squares appear in the pages with drawings in corners and center. The size of the 
drawing can be modified as at standard Windows applications. Move the mouse on a square 
to change the drawing size and drag it to the direction you want to change the drawing size. 
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Since you attain the desired drawing shape, click on the button Entry to adjust the drawing 
according to the new appearance. 

 
Another way to change the drawing size is to use the standard drawing forms. Click with the 
right mouse button in the graphic area. Short menu appears on the screen  
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wherefrom you should select the option Sheet Setup… The same effect is acquired by double 
clicking the picture that you want to change, shown in the Layer operating area (in this 
example Picture 1). The Drawing Setup dialogue box enables setting up several drawings on 
one page, defining page head line (Head Line tab) and positioning the accompanying texts 
(Annotation tab).  Concearning this example, three drawings are positioned along the height 
of the page (Number of Pictures, Height 3). 
 

 
 
The button structure placement, defines the orientation of the structure in the drawing. In this 
example, it is set as default i.e. in the middle of the drawing. 

 
 
The button Set enables defining of the views, 
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and displayed colors. 
 

 
 
In the current example, they are set as default. You can enter elements in the drawing on two 
ways. The first is in the left part of the screen, so you should check the Numbers of nodes 
square box in the Result Types operating environment. 

 
The second way is by clicking on the icon: 
 

 Draw System Variables 
 
and selecting system variable to be drawn in the dialogue box, in this example System 
variables→Definitions→ Numbers of nodes. 
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Text tab allows adjustment of parameters in the text used for displaying the numbers. 

 
 
As a result of the previous operations, node numbers in the structure are displayed. 

 
 
Since you enter numbers in the drawing, you can use the slide bar Text height to quickly 
change letter size. 
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The button Aa calls up the Draw system-definitions dialogue box for detail layout of the text 
properties. 
In the next steps, new picture will be placed in the page. The drawing will contain the 
structure with the numbers of structural elements.  
 

 
ICON:       New Picture 
MENU:     Edit→New Picture 

 
By assumption, WinGraf inserts new picture with the same content as the last created picture. 
To modify its content, you should define the system variable in the drawing, using one of the 
previous two explained methods, so in this example shows node numbers. 
Through the Result types operating area 
 

 
 
or the icon 
 

 Draw System Variables and Draw system-definitions 
 
select  Definitions of elements→Numbers of elements. 

 
 
You can create the third drawing similarly to the previous method, so it will display numbers of 
structural elements cross sections. 
 
Draw system-definitions→Definitions of elements→Numbers of cross sections 
 
The final look of the first page is shown in the following picture: 
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On the next page, you will place the structure and its loads. In the three pictures located on 
the second page, the three defined load cases are displayed.  
New page (sheet) is inserted by: 
 

 
ICON:          New Sheet 
MENU:        Edit→New Sheet 

 
The new sheet starts with the same drawing schedule, as defined on the previous page, as 
well as the same first drawing as the last created. 
 

 
 
The new page is inserted in the book contents, showed on the right part of the screen in the 
Layer operating environment. 
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Introduction of  the loads in the drawings follows the same procedure as for system variables. 
Select Loads in the Result types operating area 
 

 
 
 
or click on the icon 
 

  Draw loads 
 
to start Draw loads dialogue box and to select Trussing→Forces→Load of trussing in global 
Y.  
Select 1:Stalen tovar from the Loadcase  combo box. 
 

 
 
Representation  combo box allows several ways of showing the results. 
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For the second load case, choose the load direction along the projection of the global Y-axis. 

 
 
The third load case is characterized with loads in direction of global X and Y axes. Each of 
these load cases is placed on separate layer. Initially, load in global X-axis direction is shown. 
 

 
 
Results of the already entered loads are shown on the following picture. 
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New layer is activated with: 
 

 

ICON:            New Layer 
MENU:          Edit→New Layer 

 
The procedure is repeated as when entering the load in global X-axis. 
 

 
New load is presented in the last drawing. 
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Simultaneously the drawing 3 of the second page is demonstrated in the book content to have 
two layers.   
 

 
 
Reactions in the supports will be shown on 6 drawings placed on one page. Each support will 
be shown on separate layer. First, insert new sheet in the book. 
 

 
ICON:        New Sheet 
MENU:       Edit→New Sheet 

 
Assuming, the new page maintains the format of the previous one, namely it has three 
drawings disposed by the page height. In order to make a change we can use the icon: 
 

 Sheet setup, 
 
 
or to double click the text Picture 1, in Page 3, from the Layer operating area. In the Drawing 
setup dialogue box,  
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set the number of drawings along the width 2 (Numbers of  pictures. Width). Reactions are 
positioned in the third category of drawings Draw results.  
 

 
ICON:          Draw Results 
MENU:        Select→ Draw Results… 

 
Select the following options in the dialogue box. 
 

 
 
Element  Nodes 
Resultgroup  Nodal support forces 
Resultype  Nodal support forces in global component 
Loadcase  1:Stalen tovar 
Representation Vector 
 
The drawing gets new form with signed reactions in the supports. 
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The idea is to show every support in one window. For that pupose you should change the 
outlook if the drawing.  
The icon 
 

   Box 
 
enables zooming of the part of the drawing which is to be shown in the next outlook. By 
clicking the left mouse button, a rectangular frame is drawn which embraces the part of the 
structure to be shown by the new outlook. 
 

 
 
After releasing the mouse button, the drawing changes its content and demonstrates the 
elements of the structure which were entirely placed in the selected frame. 

 
 
The group of tools: 
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is used for selective disposal of the structure elements. 
 

 All structural elements are shown 

 Only elements in the selection frame are shown 

 A dialogue box to enter precisely the coordinates of the selection frame 

 Only elements that belong to a group are shown 

 Elements from all groups are shown 
 
Repeating the procedure previously described for the left support, drawings for the remaining 
reactions of the supports for the three load cases are created. Initially new drawing is 
inserted. Because the new drawing has the same content as the previous, with the help of the 
icon: 
  

  Structure limits 
 
all drawing elements are displayed, and after that the command: 
 

 Box 
 
is used to draw the frame to select the elements from the right support. 
 
Thus, gradually adding drawings in the book one by one, all reactions in the supports are 
represented for the three load cases.  

 
 
At last, new sheets are added where deformations and forces of the structural elements are 
shown.  
Insert new sheet and format it so as to show two drawings on page height. Drawings 
appertain to the Results group. Using the icon, from the menu 
 

 
ICON:            Draw Results 
MENU: Select→ Draw Results… 

 
a dialogue box is called up 
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where following options are selected: 
 
 
Element  Nodes 
Resultgroup  Nodal displacements 
Resultype  Nodal displacement in global Y 
Loadcase  1:Stalen tovar 
Representation Vector with variable colors 
 
The same effect can be achieved thru Result type operating area by selecting the option 
Nodal displacements in global Y. 
 

 
 
Node displacements are represented on the drawing in the global Y-axis direction. Also a 
legend is shown with different colors which represent displacement values. 
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To display the forces, you should insert new drawing in the page and select: 

 
 
Element  Trussing 
Resultgroup  Trussing normal forces 
Resultype  Filed line representation 
Loadcase  1:Stalen tovar 
Representation Vector with variable colors 
 
The final configuration is shown in the following picture: 
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The last two pages will be created simultaneously. Before activating the command for 
creating new sheet, click on the drawing with the displacements. Thereby a drawing is active. 

 
 
Click twice on the command New Sheet. 
 

 
ICON:          New Sheet 
MENU:         Edit→New Sheet 

 
Insert two new sheets in the drawing book, in which by assumption, the last active drawing is 
inserted. 
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With the icon: 
 

 Select loadcase 
 
choose a load case in where displacements are drawn, 
 

 
 
regarding the current example it is Loadcase 2 Sneg. 
 
If you have to select the next load case, use the icon: 
 

 Select Next lc 
 
namely, for the last load case use the icon: 
 

  Select Former lc 
 
A new drawing is inserted in the sheet. As content, the drawing has the deformations created 
in the previous drawing. 

 
 
Now, activate the command: 
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ICON:            Draw Results 
MENU: Select→ Draw Results… 

 
and select a new type of results: 
 
Element  Trussing 
Resultgroup  Trussing normal forces 
Resultype  Filed line representation 
Loadcase  2:Sneg 
Representation Vector with variable colors 
 
WinGRAF automatically changes the drawing content. 

 
 
Similarly drawings an page 6 are created, and represent the deformations and forces from the 
Veter load case. 
The drawing book contents can be listed using the following group of icons: 
 

 
 

 Shows the first page 

 Shows the previous page 

 Shows the next page 

 Shows the last page 
 
Similar slide bars are used to list the pictures: 
 

  
 
and layers 
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The following group of icons: 
 

  
 
are used to delete a page, drawing or layer. 
 

 Deletes a page 

 Deletes a drawing 

 Deletes a layer 
 
Representation of the structure in different projection is performed with the following group 
icons:  
 

  
 

 Displays a structure projection in XY plane 

 Displays a structure projection in XZ plane 

 Displays a structure projection in YZ plane 

 Displays axonometric projection of a structure 

 Commits mirror reflection around vertical axis 

 Commits mirror reflection around horizontal axis 

 Commits drawing rotation for 90° 

 Activates the Animator where structure outlook is allocated. This viewpoint is 
transferred in WinGRAF  

 Turns off the perspective view of a structure 
 
 
The drawing book is saved on the disk using the classic Windows command Save as.... The 
extension of these files is .GRA. 
 



 
 
 

 
4-64        SOFiPLUS_Tutorial_IGH.docf 

 

4. Example 1 : Steel Hall 
 

4.1 HALL DESRIPTION 
The structure of the steel hall is designed from 8 steel frames placed on 10 meter mutual 
distance. The frames are composed of 3 bays with bay width 12+16+12 meters. The end 
columns are 6 meter high and the center of the frame is 8 meter high.  

 

4.2 AutoCAD PREPARATIONS 
 
The whole structure is drawn as 3D model. The formwork plan of the structure is represented 
in x-y plane. The frames are spreading in X direction (transverse direction) and the positive Z 
direction is vertically upward. It is desirable to use layers for drawing the structure. In order to 
eliminate eventual mistakes, all structural elements should be visible and easy to select. Text 
lines, dimension lines and any other auxiliary lines can interrupt when selecting the elements. 
Therefore it is usual such elements of the drawing to be placed on separate layers. Every 
designer has its own work style, so there should not be strict rules in organizing the drawing. 
One practical method when organizing the drawing is using three viewports. 
 
Menu: AutoCAD→View→ Viewports→3 Viewports 
Command: _-vports 
Enter an option [Save/Restore/Delete/Join/SIngle/?/2/3/4] <3>: _3 
Enter a configuration option [Horizontal/Vertical/Above/Below/Left/Right] 

<Right>: Left 
 
Before start of the design process, it is required all layers without structural 
elements to be closed. The drawing is saved by file name: CELICNA HALA 
SOFiPLUS.DWG. 
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4.3 STRUCTURAL SYSTEM  
The steel hall will be treated as spatial structure. The analysis will be 
performed according EuroCode (EC 2). Structural system is called up by: 
 

 

ICON: SOFiPLUS 
MENU: SOFiPLUS→Structural system… 
Command: SOF_GSYSMOD 
 

In the dialogue box Data Base Description and Choice  
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enter the following parameters for the data base:  
 
 
Project Celicna hala 
Database CELICNA HALA SOFiPLUS 
Orientation of Self 
Weight: 

Pos. Z axis 
(Direction of the self weight is in Z direction) 

Maximum number of 
element per group 

1000 
(In frame systems usually the number of elements divided in 
groups are small) 

Point size 0.05 
Structural mode Space 
Database coordinate 
system 

SOFiSTiK 
(Positive orientation of Z axis is vice versa direction of the Z axis 
defined by WCS in AutoCAD) 

Drawing units m 
 
Data base is automatically created under the name of the drawing: CELICNA HALA 
SOFiPLUS. 
 

4.4 MATERIAL 
 
Structural elements of the hall are made from standard steel.  
 

 

ICON: Material 
MENU: SOFiPLUS→Defined model→Material 
Command: SOF_GSYMATE 

 4.4.1  
 
The dialogue box on the screen shows predefined materials which are not taken under 
consideration in this example.  
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With the button Delete All, all materials are deleted. By clicking New… button, new dialogue 
box is opened where from the following options are selected:  

Type    (EC 2) Structural Steel 
Classification  510 

Because it is standard material it is not necessary to activate other buttons (Property, . . .) in 
order to adjust other material properties. 
 
 
 
 
 

 
 

4.5 CROSS SECTIONS 
 
Cross sections of the structural elements are presented in the following table: 
 

Columns 2 [] 30 
Beams HEA 40 
Wind bracing   

 

 

ICON:  Cross Section 
 MENU: SOFiPLUS→Defined model→Cross Section 
Command: SOF_GQUER 

 
In the beginning the list of cross sections is empty. Gradually with the button New ... the cross 
sections used in the example are added in the model. It is not problem to define other cross 
sections if needed during the design process. 
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From the group of standard cross sections Rolled steel is selected. 

 
 
In the combo box Type select HEA and 400. 
The second type is rectangular cross section which is contained by 2 [] profiles. Repeat the 
action for defining new profile. 
 New→Rolled Steel 
Now, select: 
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 Type→U→300 
In order to achieve rectangular profile, the sketch should be mirrored around Z axis (vertical 
axis). Place: 
 
 Reference point→Top right 
 Mirror→on Z axis 
 
The results can be previewed in the Preview window. If needed, separation of the profiles can 
be accomplished by declaring YM and ZM values. The cross section can be rotated by the 
Textbox - Angle. 
The third profile is channel with the following geometry: 
 Diameter→51 mm   and    Wall-thickness→2.0 mm 
 

 
 
The list of the cross sections has the final form: 
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CREATING OF STRUCTURAL ELEMENTS 
 
At first columns are to be created. Columns are beam elements. They can be created with: 
 

 
ICON: Beam element 
MENU: SOFiPLUS→Create finite element→Beam element 
Command: SOF_G 

 
This method for creating columns is very unpractical. There are a lot of columns and each has 
to be created separately. In such cases more efficient to use is the function Generate with 
objects. 
 

 

ICON:   Generate With Objects 
MENU: SOFiPLUS→ Generate→ With Objects 
Command: SOF_G 

 
This opens dialogue box where the type of the elements which will be created with the 
following command, are to be selected. (in the example Beam). 
Minimal edge length of the elements can be defined if some elements from the group which is 
selecting, with length smaller than defined, has to be excluded.  Number of the group must be 
indicated if the elements which are to be created has to be assembled in separate group.  
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By using Crossing Windows, all columns from the frames are selected. (Lower right viewport 
is used). 
 

 
 
Command: 
Select objects: Specify opposite corner: 28 found 
(use Crossing Windows, P1 – P2) 
Select objects: Return 
 
Searching intersections ...... 
Treating partial-lines ... 
Making Elements ... 
First Beam No.<1>: Return  (predefined element number 1 is accepted) 
Section number<1>: 2      (number of the section is 2) 
 
Creation of the beams is similar. Initiate again the command: Generate With Objects.  
 

 
Make sure Break entities on intersection is checked. Beams are drawn by continuous lines. In 
the intersection points, node points should be inserted and elements are supposed to be 
created between intersecting point of the lines. 
Use Window to select the lines. 

 
Command: 
Select objects: Specify opposite corner: 72 found 
 
Select objects: Return   
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Searching intersections ........ 
Treating partial-lines ... 
Making Elements ...- 
First Beam No.<29>: Return  (predefined element number 29 is accepted) 
Section number<2>: 1    (number of the section is 2) 
 
Wind bracings can be formed directly. They are made from diagonally crossed steel channels, 
positioned between the first and the second, and the last and the last by one frame. Because 
of great slenderness these elements can not resist pressure. Therefore in the model they are 
going to be represented by Cable elements. 
 

 
ICON: Cable 
 MENU: SOFiPLUS→Create finite element→Cable 
Command: SOF_G 

 
 
Command: 
Node NA (end+cen+nod+int+ext): (Click on the first node) 
Node NE (end+cen+nod+int+ext): (Click on the second node) 
 
Section number<1> or [Prestress force]: 3  
 
First Cable No.<1>: 
 
Node NA (end+cen+nod+int+ext): (continue entering other elements) 
 
For easy defining cables, it is possible to draw auxiliary lines which will be converted to 
structural elements with Generate With Object command.  

 
 
It must be taken care about mutual passing of each diagonals of wind bracings. They do not 
form common intersection point. 
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Make sure Break entities on intersection is not selected. 
 

 
 
You can now select all elements of the wind bracings. It is possible to use all Viewports and 
all AutoCAD methods for selecting. 
 
Select objects: (Select all diagonal elements) 
.. 
Treating partial-lines ... 
Making Elements ... 
Section number<3> or [Prestress force]: Return  
(Accept the offered number of the section) 
     
First Cable No.<1>:   Return   
(Accept the offered number for starting number of cables to be generated) 
 
 
Diagonal element in the last bay are exactly the same as diagonal elements from the first bay. 
Thus, AutoCAD command Copy will be used to generate these elements. 
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After activating Copy command, all diagonal elements from the wind bracing are selected. As 
a Base point is used the lower point of the column. The copying procedure starts from the 
column of the last by one row. 

 
Systems in which AutoCAD tools: Copy, Array and others are used should be checked. It is 
desirable to perform structure check after generation process, even if the standard way of 
generating structural elements is used. With this control all mistakes made in the method, like 
folding over of two points or accidental deletion of nodes, are eliminated. 
Start the command for transferring data into the analysis database. 
 

 

ICON:  SOFiPLUS→Export 
MENU: SOFiPLUS→Analysis Data Base (CDB)→Export(..  
Command: SOF_GENFOUT 

 
Select the option Check run (no output) in the dialogue box. 
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It is sometimes required to repeat this procedure with the purpose of eliminating the mistakes. 
 

4.6 ORIENTATION OF ELEMENTS 
 
Beam elements have local co-ordinate system x, y, z. Starting point NA and ending point NE 
define the positive direction of the X-axis. 
 

 
In case of plane frame structure, the direction of Y-axis is defined so bending always happens 
around that axis.  
Depending of the orientation of the other two axis, three cases are distinctive: 
1. Plane frame 
The structure lies in the global XY plane. Local Y-axis of the beam is parallel to global Z-axis 
but has opposite direction. Local Z-axis is perpendicular to beam axis and oriented on right of 
the beam direction. 
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2. Plane grid  
The structure lies in global XY plane. Local Z-axis of the beam is parallel to global Z-axis. 
Local Y-axis of the beam is parallel to beam axis and oriented on right of the beam direction. 
 

 
 
3. Space system 
In three dimensional systems orientation of the local Y-axis must be defined by the user. 
Local Z-axis is perpendicular to local X and Y axes. It’s direction is determined according right 
hand rule. 
These cases can occur: 
 
Local Y-axis is parallel to global XY plane and perpendicular to beam axis, and on the right 
of beam direction. This is independent from gravity direction and always in clock-wise 
direction in respect to global Z-axis. 
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Beam axis is parallel to global Z-axis, so the local Z-axis is parallel to global Y-axis. 

 
Beam is freely oriented in the space. 
In such cases the designer should be particularly careful. It is recommended to create visual 
control of the beam orientation. 
 

4.7 BEAM ORIENTATION CONTROL 
 
SOFiSTiK offers efficient way to control the beam orientation.  
 

 
ICON:  SOFiPLUS→Display Beam Coordinate Systems 

MENU: SOFiPLUS→Visualize→ Display Beam Coord. System 
Command: SOF_G 
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Command: 
Factor<0.0000> or [SEttings/STart/Mid/End]: M 
 
Elements to be visualize (RETURN=All) 
Select objects: (select the elements in which local coordinate systems are to be shown) 
 
In the first line of the command it is required to select a point where local coordinate system is 
to be placed.  
Settings – select color and size of the arrows which will represent coordinate system 
Start – coordinate system is placed in the beginning point of beam (NA)  
Mid - coordinate system is positioned in the middle of beam (NA)  
End - coordinate system is positioned in the ending point of beam (NE)  
 

 
In the this example local coordinate system of the columns is being controlled. After selection, 
in the center of the columns local coordinate system (Y-axis) is shown. Local coordinates of 
the columns are compared to coordinates considered when cross sections are defined. 
 

 
From the results of the performed control it is obvious that greater moment of inertia is around 
Y-axis. This position of the section performs bending of the elements from the frames around 
Z-axis, which is not correct.  
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With the intention of using greater bearing capacity of the section in the Z direction it is 
needed to rotate the section for 900.  
 

 

ICON:  Cross Section 
MENU: SOFiPLUS→Defined model→Cross Section 
Command: SOF_GQUER 

 
Select cross section 2 and click on Modify ... 
 

 
 
Change the angle value to 90. 

 
 
Visualization of the beam local coordinate systems shows that local axis of the beams folds 
over Y-axis of the cross section. Bending is around the axis with greater moment of inertia. 
Beams are correctly oriented and there is no need for changing cross section orientation.  
 

4.8 RESTRAINTS 
Supports of the steel hall members are fixed. In order to apply the restraints in which 
structural members are supported, modification of the nodes is required. 
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ICON: Modify node 
MENU: SOFiPLUS→Modify finite element→Node 
Command: SOF_GNOTMOD 

 
Select the nodal joints which will be restrained from displacement. 
Command: 
Select option <Select objects>[Select objects/Enter number/Pick nodes]: S 
Accept the offered option. <Select objects>.  

 
After selecting the nodes, in the opened dialogue box check the boxes for constrained 
degrees of freedom. 
 

 
 

4.9 VISUALIZATION OF THE RESTRAINTS 
 
For the purpose of showing the restraints of the structure, visualization is performed. 
  

 

ICON:  Display restraints 
MENI:  SOFiPLUS→Visualize→Restraint 
Command: SOF_GFEST 

 
When asked  
Einstellungen? [Ja/<Nein>]: J 
answer with N (nein)and the predefined properties of the vusualization are accepted. 
 

4.10 LOADING 
All loading cases are defined. Load distribution depends on the type of the roofing structure 
and curtain walls. In this example load analysis is not performed, so predefined loads are 
accepted: 
 
Roof weight   0.10 kN/m2 
Snow weight   0.75 kN/m2 
Wind preasure  1.00 kN/m2 
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Wind suction   0.50 kN/m2 
 

 
ICON:  Loadcase Manager 
MENI:  SOFiPLUS→Loadcase Manager 
Command: SOF_GLFMOD 

  
 
In the beginning the list of load cases is empty. Clicking on Button New...  enter three load 
cases. 
 

 
 

4.10.1 Dead load 
 
In this example loads which act on the roof are directly transferred on the frames. By 
multiplying the uniformly distributed load with the frame span (for middle frames), or half the 
frame span (for ending frames) equivalent frame loads are the result.  
Dead load is placed as current load case. 
  

 
ICON:            Beam load 
MENI:  SOFiPLUS→Create loads→Beam loads 
Command: SOF_GXLAS 

 
Command: 
Select option <Select objects>[Select objects/Enter number/Pick Beam]: Return 
 
Select objects: (select the internal beams) 
Select objects: Return 
. 
Distance from beam start<0.0000>: Return 
Load end distance from beam end<0.0000> or [Further-beam/Point load/Load length]: F 
 (F- load also acts on the next beam)  
next beam (nea): 
Load end distance from beam end<0.0000> or [Further-beam]: 
Load type [Load/Moment/Pre-displacement/Temperature]: l 
Load [PS/P1/P2/PX/PY/PZ/PXP/PYP/PZP]: PZ 
(Roof load acts on the downward beam length-global Z axis) 
Load in kN or [Variable load]: 1.00 
 (0.10kN/m2 * 10m = 1.00 kN/m’) 
Select option <Select objects>[Select objects/Enter number/Pick Beam]:  
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(continue with entering loads on ending beams with value 0.5 kN/m’) 
 

 
4.10.2 Snow load 

 
Before entering next loads, it is suggested to make all other loads invisible. Activate AutoCAD 
function Layer Property Manager, and switch off the layer named XV__S001_HALA1. It is 
possible to use SOFiPLUS tools for switching off certain load cases. 
 
SOFiPLUS→Vizualize→Delete vizualization 
 
Select &Loads and Switch Off 
 

 
 
which turns off all load cases from the viewing point. The procedure for entering snow load is 
the same as entering dead load.  
The difference is that snow acts on horizontal plane. Label for this load is: PZP 
 
Load [PS/P1/P2/PX/PY/PZ/PXP/PYP/PZP]: PZP 
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In this example asymmetric snow load is taken under consideration.   
 

4.10.3 Wind load 
 
Lateral wind load is studied. In this example wind acts only on the beams. The wind direction 
is global Y-axis.  
Load [PS/P1/P2/PX/PY/PZ/PXP/PYP/PZP]: PY 
Wind preasure is 6 kN/m’ and wind sucking is  3 kN/m’. 
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4.11 TRANSFERRING DATA INTO DATABASE 
When the model of the structure is prepared and all load cases are entered, the data are 
transferred into analysis database. 
  

 

ICON: SOFiPLUS→Export 
MENI:  SOFiPLUS→Analysis Data Base (CDB)→Export(..  
Command: SOF_GENFOUT 

 
Command Export transfers all the data which were saved within a drawing into analysis 
database. 
  

 
 
By accepting the offered options, preprocessing process finishes. 
 

4.12 STRUCTURAL ANALYSIS 
 
The analysis is made with the program WTED. 
  

 

ICON:  Edit (Win Ted) 
MENI:  SOFiPLUS→Analysis … 
Command: SOF_G 

 
In the dialog box enter the file name for input: CELICNA HALA SOFIPUS.DAT. 
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Working area of the program WTED is displayed. 
 

 
 
Modify module  
+PROG GRAF 
in order to output calculation results for three load cases. Some predefined modules which 
are sufficient for the current analysis are eliminated. (In this example MAXIMA and AQB) 

 
 
The control box from the analysis process shows that modules AQUA and GRAF are 
completed without errors and module STAR2 has warnings. 
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This warnings should be carefully examined. To display SOFiSTiK messages, you should run 
Ursula program. 
  

 Ursula is used for creating output file, which contains text and graphical presentation 
of the results. 
 

 
 

4.13 Tool 

   Search warning enables fast positioning of the warnings. In this example, warning 
message is: 

 
 
This warning shows that cable elements are used for modeling the structure. When cable 
element are being used, analysis process must be iterative or cable elements should be 
replaced with truss elements. 
 

4.14 EXPLANATION 
 
In the first analysis, this program determines forces in the elements. If cable element is 
exposed to pressure it should be eliminated from the analysis (because of great slenderness 
cable elements cannot resist compressive stresses). The process should be repeated without 
participation of the compressed cable elements. It is iterative process executed in few cycles. 
In this example modifications are made in STAR2 module. Number of iterations are limited to 
2. 
 CTRL II 5 
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Results from every iteration are requested. 
 ECHO STEP 1 
 
 
 
PROG STAR2 
HEAD WIND TO THE LEFT - WIND TO THE RIGHT 
CTRL II 5 
ECHO STEP 1 
LC 1 
NL 2 PX 10 
END 
CTRL II 5 
ECHO STEP 1 
LC 2 
NL 3 PX -10 
END 
 
Depending on the structural system, EXECUTE activates few predefined modules. Detailed 
explanations about contents and functions of those modules are presented in their manual. 
For complete analysis process, some predefined functions and functions which have to be 
included in the analysis are explained. 
 

4.14.1 +PROG AQUA  
is for calculating geometrical properties of the cross sections. Static values can be also 
entered as well as dimensioning or stress check of the section. Predefined values in AQUA 
are: 
 
+PROG AQUA   -E urs:1 
PAGE firs -1 
ECHO full no; ECHO sect yes 
END 
 
PAGE - Control of Input/Output – Control of input/output data. 
 
First – number of the first page, if negative page numbering is not performed. 
 
Line – number of lines per page 
 
LANO – output file language code 
German 
English 
French 
Spain 
 
LANI – input file language code 
  
       UNIO – input file system units 
 UNII – output file system units 
 
SOFiSTiK supports following system units: 
 
0   =Standard units of SI-System 
1   =General structural engineering (e.g. cm instead of m) 
2   =Steel construction, SI-System (e.g. mm instead of m) 
3   =Concrete bridge construction, SI-System (e.g. MN instead of kN) 
4   =Foundations, SI-System (e.g. MN instead of kN) 
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5   =Hydrology 
8   =Standard units of US-System 
9   =General structural engineering in US-System 
10 =Steel construction in US-System 
11 =Concrete bridge construction in US-System 
12 =Foundations in US-System 
 
 

4.14.2 ECHO - Extent of Output 
 
 
 
 
Member Description Type Default 
OPT  Text FULL 
 Material parameters 

Cross section elements 
Element references 
Cross section values 
System statistics 
Drawings characteristics 
Integral method for equations 
Selection of all options 

MAT 
SECT 
REFP 
SDEF 
SYST 
PICT 
IEQ 
FULL 

 

VAL  Text FULL 
 No calculation/output OFF  
 No output results NO  
 Normal output results YES  
 Extended output results FULL  
 Extreme output results EXTR  
 
By default SOFiSTiK offers: 
 ECHO full no; ECHO sect yes 
which stands for generating output results only for cross section elements 
Small correction in the input data is made in AQUA, in order to display results in English. 
 
+PROG AQUA   -E urs:1 
PAGE firs -1 LANO 1 
ECHO full no; ECHO sect yes 
END 
 
Output results presented in URSULA are: 
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4.14.3 + PROG GRAF 
 is used for graphical presentation of the structure and results. It is predefined to call up twice. 
In the first case graphical presentation of the structure is called up. 
 
+PROG GRAF   -E urs:2 
VIEW STAN 1 1 1  POSZ 
SIZE HP4 
STRU 1 1 
STRU sno 
END 
 
VIEW -View Specification   
 
ÄÄÄÄÄÄÄÄ 
Member Description Type Default 
TYPE Element presentation Text angle 
 View point (X, Y, Z) 

View line  
Axonometric angle X, Y, Z 
Reduction factor X:Y:Z 

STAN 
DIRE 
ANGL 
SCAL 

 

X -/degrees 0 
Y -/degrees 0 
Z 

Direction for TYPE 
(line view or angle or reduction) -/degrees 0 

AXIS Orientation for STAN, DIRE and SCAL Tekst  
 Positive  x-axis downward  POSX  
 Positive  y-axis downward POSY  
 Positive  z-axis downward POSZ  
 Negative x-axis downward NEGX  
 Negative y-axis downward NEGY  
 Negative z-axis downward NEGZ  
ROTA Additional rotation in the drawing in clock-wise position Degrees 0 
 
In this example, predefined values for the view are: 
VIEW STAN 1 1 1  POSZ 
Which denotes view point with coordinates 1, 1, 1 and determines positive direction of Z-axis. 
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SIZE - Scale and Paper Size  - Paper format for printed results is defined.  
 
In this example, predefined paper format is A4. 
 
SIZE HP4   
 
 
 
 
 
 
 
STRU - Representation of Structure Values  
 
Member Description Type Default 
NUME Element presentation -/Text - 
 Draw one element 

Do not draw element 
Element numbers 
Group numbers 
Material numbers 
Cross section numbers 
Cross section contours 
Do not generate BRIC areas  
Accept BRIC areas 
Contour areas only 
Do not draw structure 

- 
0 
n 
GRP 
MNO 
SNO 
SECT 
SPAC 
GLAZ 
CONT 
NO 

 

NUMK Draw node numbers - - 
 Draw any element number -  
 Do not draw numbers 0  
 Number of every n node n  
 Number of supports FIX  
 Extreme output results EXTR  
OFFE Beam element distance numbers - 0 
OFFK Node numbers distance - 4 
 
Predefined values are: 
STRU NUME 1 1 
STRU sno 
meaning creating of two drawings, one with node and element numbers and the other with 
cross section numbers. Node and element numbers start from 1 
 

 
 
Lightning bulb before GRAF is used for turning GRAF on or off in the book for output results. 
 
ICON 

  
works by switching on/off. You can turn off certain drawings from the book with output results.  
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4.14.4  PROG STAR2 –  
Module for static calculation of frame structures 
Depending on input data, this program identifies three operating modules: 
 
load generation 
analysis  
restart 
 
In this example loads are completely defined with SOFiPLUS. Eventually additional load 
cases can be defined with the program STAR2. 
 
CTRL - Parameters Controlling the Analysis Method  
 
 
Member Description Type Default 
OPT Control options Text I 
VAL Optional values -/Text * 
 
Available options 
 
LIT Description Value Default 
I First order theory (dilatation control) nIter 1 
IB First order theory (stress control) nIter 1 
II Second order theory (dilatation control) nIter 1 
IIB Second order theory (stress control) nIter 1 
III Third order theory (dilatation control) nIter 1 
IIIB Third order theory (stress control) nIter 1 
GEN Force and displacement tolerance In 0/0 1.0 
GENM Moment and rotation tolerance In 0/0 1.1 
AFIX Managing degrees of freedom which are freely 

displaced 
- 1 

Cable element management Text CABL 
Cables can accept only tension CABL  

STYP 

Cables can transfer compression TRUS  
GDIV Element grouping factor - * 
 
 
Predefined value for CTRL is I, which means that analysis is going to be executed by first 
order theory. 
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As a result for predefined values, URSULA creates output data for all three load cases. 
 

 
 
Echo of the load input data. 

 
Results of the static values in the beam elements. 

 
 
Finaly forces in cable elements are entered. 
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Message at the end of the results for cable elements should be taken under consideration. If 
cable element results are analyzed, some elements are tensioned while others are 
compressed. This is not according the idea for cable elements which have to be tensioned. 
This warning is that case. Axial tensioned cable elements can not be achieved only by one 
analysis. SOFiSTiK registers such cases and sends message to use TRUSS elements in the 
analysis, some axial compressed elements can occur, or to solve the problem by iteration. 
This iteration means that after analysis is finished, structure is checked for axial compressed 
elements. If there are such elements they are eliminated from the model of the structure 
(because of high slenderness they can not bear compressive forces).     
Analysis is repeated with the new model. Redistribution of forces is done, so new axial 
compressed elements may occur. In the next iteration such elements are eliminated from the 
analysis and the process continues with few iterations until final solution, without axial 
compressed elements, is succeeded. Usually number of iterations has to be limited or other 
criterions for controlling exact solution are applied. To make nonlinear analysis of the 
structure, modification in module AQUA is done. 
  
 CTRL II 5 
 
This problem has to be solved using second order theory with maximum 5 iterations. 
URSULA creates additional results. Apart from results of linear analysis (first iteration), final 
results are presented by eliminating compressed cable elements.   
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Results for cable elements clearly show that axial compressed elements were not included in 
the analysis. 
 

 
 
There is no compression in the cables.  
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4.14.5 ECHO - Control of the Output Extent  
 
Member Description Type Default 
OPT Text from the applied list Text  FULL 
 Node coordinates, limitations NODE  
  Beams BEAM   
 Springs SPRI  
 Boundary elements BOUN  
 Cross section values SECT  
 Loads LOAD  
 Cross section forces FORC  
 Beam deformations DEFO  
 Node displacements BDEF  
 Reinforcement REIN  
 Stress and strain NSTR  
 Output results for all iterations STEP  
 All options FULL  
VAL Output option values Text FULL 
 No output results NO  
 Standard output results YES  
 Complete output results FULL  
 Extended output results EXTR  
 
Predefined values: 
 
ECHO full no 
Echo forc,load full 
 
denote complete output for forces and loads. 
 
 

4.14.6 +PROG GRAF 
Graphical presentation of results 
Program GRAF is called up again to insert drawings with results from analysis. By default 
only results from the first load case (LC 1) are entered. 
 
LC 1      
BEAM VZ          
BEAM MY              
BEAM N     
 
For results and other load cases input results have to be added in GRAF.  
      

4.14.7 BEAM -Beam Element Results  
 
Member Description Type Default 
TYPE Type of structural element Text  - 
UNIT Values presented with 1 cm  * * 
SCHH Text height cm  H6 
STYP Type of elements SPRI  
 Boundary elements BOUN  
  Cross section values 

BEAM beam element 
CABL cable element 
TRUS truss element 

Text * 
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PIPE pipe element (pile) 
DTYP Type of representation Text * 
UNI2 Same as UNIT for second type * * 
MNO Number of material for composite sections or text for 

point which stress is calculated in AQUA 
- * 

STAT MAX maximums only 
END maximums and beam endings 
SECT all beam sections  

Text END 

MIN Lower text limit * 0. 
MIN2 Lower text limit for second type * 0. 
OFFS Text distance cm 0. 
ND Number of decimal places  - * 
VAL Output option values  Text FULL 
 
By default only graphical results of beams are displayed. 
    

 
 
Nine new drawings are entered in the book of results. 
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Icon Rotate Picture is used for rotating the drawing for 900, in one or the other direction. For 
this purpose drawing should be first selected by clicking with the mouse on the drawing in 
URSULA, and then icon depending rotation direction is clicked.  

 
Next click on the icon rotates the picture for another 900 and so on until desired orientation of 
the drawing is achieved. Results for cables can be displayed in addition. 
Because results from the analysis are in analysis database they can be shown separately. 
For instance, if new book with drawings, which will contain only cable forces, has to be 
created unneeded modules are switched off (by clicking the + sign becomes -). 
Change in GRAF is made so only cable forces are drawn. 
+PROG GRAF  -E urs:4 
VIEW STAN 1 1 1 POSY 
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SIZE HP4 
LC 1                 
BEAM N STYP CABL             $ Cable N 
LC 2 
BEAM N STYP CABL             $ Cable N 
LC 3 
BEAM N STYP CABL             $ Cable N 
END 
and all modules except GRAF are turned off. 

 
 
As a result of these changes, new book with drawings is created, 

 
 where cable element forces are introduced. 
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5. Example 2 : Administrative Building 
 
This building is octagon based, with edge length of 10 meters. Cross sections of the floors are 
shown on the following pictures. First, slabs are analyzed as independent structural systems. 
Three floors are characteristic: basement floor, ground floor and first floor. 
 

5.1 BASEMENT:  
The outline couture of the slab is supported on concrete walls with thickness of 20 cm. Slab in 
the center has 5 m round opening. Supports in the center are circle columns with 40 cm in 
diameter. 
 
 

 
 
Stairs are surrounded by two concrete walls (d=15 cm). For simplifying the analysis, stairs 
slabs are not included in the mathematical model.  
 
 

5.2 STRUCTURAL SYSTEM 
 
Structural system is Girder/Slab grid. Analysis is going to be performed according Euro Code 
(EC 2). Structural system is set with: 
 

 

ICON:  Structural system 
MENU:           SOFiPLUS →Structural system… 
Command: SOF_GSYSMOD 
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In Data Base Description and Choice dialogue box following parameters are entered in the 
database. 
 
Project Podrumska ploca 
Database Basement 
Orientation of Self 
Weight: 

Pos. Z axis 
 

Maximum number of 
element per group 

10000 
 

Point size 0.05 
Structural mode Girder/Slab 
Database coordinate 
system 

SOFiSTiK 
 

Drawing units m 
 
Database file is created after closing the dialogue box. The file name is: 
BASEMENT 
 
 

5.3 MATERIAL 
 
Slab is made from concrete with strength 35. 
 

 

ICON:  Material 
 MENU: SOFiPLUS →Defined model→Material 
Command: SOF_GSYMATE 
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Dialogue box shows predefined materials which are not used in this example. 

 
 
Modify concrete strength. Select the material which is going to be modified (1 C 20 in the 
example). Pressing on the Modify button opens dialogue box which permits changing material 
properties. 
 

 
 

Type   (EC 2) Standard Concrete 
Classification  35 

 
Reinforcing material remains unchanged S 500. The rest two predefined materials can be 
deleted. 
 

5.4 STRUCTURAL LINES 
 
As a background for defining mathematical model, architectural drawing of the basement floor 
is used. This drawing can be used for filling structural lines which are later used for generating 
mathematical model. For outward walls usually slab contour is considered passing on 1/3 of 
the wall thickness.  
For this purpose following command is used: 
 

 

ICON:1/3 Line 
MENU:     SOFiPLUS →Defined model→Auxiliary Line→1/3 Line 
Command:   SOF_DRITTEL-LINIE 

 



 
 
 

 
5-102        SOFiPLUS_Tutorial_IGH.docf 

First click on the inner line of the wall and then on the outline. SOFiPLUS draws structural line 
on 1/3 of the inner side of the wall 

 
 
This command is used for drawing structural lines on all outward walls.  
 
Inner walls are represented by structural lines passing in the middle of the wall. 
 

 

ICON: Center Line 
MENU:        SOFiPLUS →Defined model→Auxiliary Line→ Center Line 
Command:   SOF_DRITTEL-LINIE 

 
In this case order of selecting sides of the wall is not important.  
 

 
This procedure continues with drawing structural line on the second inner wall. All structural 
elements are placed on later: X__AUFL 
 

 
 
which is formed by SOFiPLUS. 
 
Beside these lines additional structural lines are going to be drawn. Using the simple 
AutoCAD command: Line, draw lines on the contours of the slab segments. These lines have 
to be placed on layer X__AUFL. If these lines are not entered on the layer X__AUFL when 
they are drawn, relocation can be done in few ways using AutoCAD commands (Properties, 
Match Properties tool, …) or by simply clicking on the lines (grip points are showing) then 
clicking on the icon Layers and selecting the layer X__AUFL from the layer list. 
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 SOFiPLUS has its own function which transfers graphical objects on structural layer.  
 

 

ICON: Copy to structural Layer 
MENU: SOFiPLUS→Defined model→Auxiliary Line→S Copy to            structural 
Layer 
    Command:  SOF_DRITTEL-LINIE 

 
After selecting this command, click on the auxiliary lines which are transferred on layer 
X__AUFL and represent structural lines. 
This group of tools has another tool: User define Factor, which allows optional position of 
structural line in relation to wall edges.  
 

 

    ICONA:    User Defined Factor 
   MENU:     SOFiPLUS →Defined model→Auxiliary Line→S Copy to Structural 
Layer 
    Command:  SOF_DRITTEL-LINIE 

 
Command: 
Factor <0.5000>: 0.25 (Line passes on ¼ of the first selected wall edge) 
First line  (Select the first wall side) 
Second line  (Select the second wall side) 
First line  (Continue with other walls) 
 
 
 

5.5 STRUCTURE AREAS 
 
Structure areas are parts of slab surrounded by structural lines. There are two ways of 
generating structural areas: by clicking on the point inside contours of the area (structural 
lines must form closed contour) or by clicking certain structural lines which form slab contour 
area. In the second case lines do not have to intersect. SOFiPLUS continues lines to their 
intersection points. It is important to generate lines in clock-wise or opposite direction and to 
form closed contour. In this example first case is shown in the  beginning.  
 

 

    ICON:          Structure area 
   MENU:        SOFiPLUS→Defined model→Structure area 
    Command:  SOF_PM_AREA 

  
Before defining structural areas it is preferable to close all layers except layer with the 
structural lines. After that component check of structural lines is needed in order to eliminate 
errors (usually contours are not ideally closed) or to choose forming of the areas by selecting 
contour lines which do not need closed contours.   
 
Simplest way is by clicking on closed contour. After selecting this option, dialogue box 
appears on the screen asking for slab parameters. 
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Predefined slab thickness is 20 cm. It should be changed to 18 cm. If change of the material 
is necessary, buttons Slab (for concrete) and Reinforcement are used. Both buttons open 
Material dialogue box which allows change of accepted materials. Button Load… starts the 
process of defining loads for the area which is going to be generated. After the first launch of 
Loads…, Load case Manager dialogue box opens because there are no previous loads 
defined. In this dialogue box all load cases, which will be used in the slab analysis are entered 
and current load case is the first one for which load is going to be generated. In the example it 
is 1 Loadcase Dead Load.   
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5.6 Loads and Areas dialogue box 
 

 
 
allows selecting load case for dead and imposed load as well as entering load values and 
temperature difference. Since loads are placed on correct positions, click inside closed 
contour. SOFiPLUS analysis contour and if everything is properly entered and defined, marks 
the contour and displays area labels and loads. 
   

 
 
Process continues by setting point lying on the next closed contour. Before contour is 
selected dialogue box appears again, but with increased value for Imposed Load. When 
selecting closed contours, they should be fully visible on the screen. 



 
 
 

 
5-106        SOFiPLUS_Tutorial_IGH.docf 

 
 
Every slab area can have new load case for Imposed Load. In that case by combining load 
cases checkmate disposition of Imposed Load is available for inspection or determination of 
the unfavorable disposition in certain slab areas.  
We should discuss about two check boxes: Increment loadcase automatically (presumed 
option) and Don’t show this again. As stated before checking the first check box automatically 
increases the number of load case in which Imposed load for specified load is placed. The 
second check box is active only when all areas are uniformly stressed. In such cases Loads 
and Areas dialogue box do not appears, so predefined load values are declared on the areas.   
In this example we will use the second option: Don’t show this again, meaning all areas have 
same load values. 
 

 
 
Center part of the slab can not be created on the previous way. This part contains opening 
which has to be defined separately. Use: Select Boundary option: 
 
Command: 
pick Point in area or [Select Boundary]: 
pick Point in area or [Select Boundary]: 
pick Point in area or [Select Boundary]: S 
 
We should be very careful when using this method. When selecting two structural lines 
SOFiPLUS checks these lines and if the operation is regular marks the lines with one label for 
each line. 
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In some cases a line can be contained in few areas and when selecting SOFiPLUS does not 
identifies that line (line marking is skipped). Then we have to repeat selection by holding 
down CTRL and clicking on the line. Thereby cycle selection process is started.   
 
Select Boundary or [Undo]: <Cycle on> 
 
At this time click again on the line (without holding down the CTRL button). By every 
selection, next element with area equal to previous is selected. Continue clicking until right 
element is selected and then click on Entry to finish cycle selection process. If everything is 
regular new area is created on the slab.  
 

 
 
At the end slab opening should be created. 
 

 

    ICON:          Opening 
   MENI:          SOFiPLUS→Defined model→ Opening    
    Command:   SOF_PM_HOLE 

 
This way of creating openings is exactly the same as when creating slab areas. You can click 
on the closed contour of the opening or gradually select contour lines of the opening. This 
example uses first option because center slab opening has round shape.  
COLUMNS 
 
In the center area, our slab is supported on circle columns. In the mathematical model 
columns should be presented as point supports with permitted rotations and constraint 
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vertical displacements. This way of defining columns is not correct. Point slab support is 
reason for singularity and from the theory moments in point supports are infinite. Finite 
element solution is approximate and depends on the size of the elements. If finer grid (smaller 
elements) is used, precision is increased which means greater values for moments. In reality 
slabs are not point supported by columns. 
 

 
 
 

54321

54321

βββββ
ααααα

====
====

 

 
It can be presumed that the part of 
the slab which is lying on the column 
acts as solid which has same 
deformations as end of the column. 
Mathematically this means 
prescribing same rotations and 
vertical displacements to all points 
which lay on the area connecting the 
slab and column. In final element 
method this is simulated using 
CONSTRAIN, by equalizing 
deformations of those points (in this 
example point 1-4) with reference 

point (point 5).  
Other way to simulate columns is thru elastic supports on points where columns support the 
slab. Axial and rotational stiffness is calculated on the columns and they are replaced with 
equivalent axial and rotational springs. SOFiPLUS supports both ways of approximating 
columns: CONSTRAINS and elastic springs. This example uses the second way of 
approximation by applying elastic springs.    
 
 

a

ί
ί

a

a

ί ί

ί
a

a

 

    ICON:         Structure Point 
   MENU:        SOFiPLUS→Defined model→Column/Structure Point    
    Command:  SOF_PM_POINT 

 
 
Structure point dialogue box contains several tabs. First tab General is used for applying the 
name of the point/column, dimensions (x and y), positive X axis angle and slab thickness.  

 
 
x and y are dimensions of the area which approximates column supports. Angle is formed 
between local X-axis of the support and global X-axis of the system. Column cross sections 
can be assumed from the drawing by selecting column contours.  
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Command: SOF_PM_POINT 
pick Position (end+cen+int+ext) or [Outer boundary/Point in column]: O 
Select Boundary: (Select column boundaries) 
or 
pick Position (end+cen+int+ext) or [Outer boundary/ Point in column]: P (Select column 
interior) 
 
If second option is used, we should be careful to enable clear column surface without other 
closed contours. SOFiPLUS recognizes closed contours and defines support point for every 
clicked closed contour. In this example first option Select Boundary is used. Selection of 
column boundaries is performed the same way as selection of slab area boundaries. So, if 
several boundaries are present, neighboring boundaries are selected in clock-wise direction 
or vice versa. Columns with circle and user defined cross sections are replaced by equivalent 
square columns. 
  

 
 
In order to display SOF_PM_POINT effects, following command is activated: 
 

 

   ICON:        Modify Structure Point 
  MENU:       SOFiPLUS→Defined model→Modify Column/Structure Point    
 Command: SOF_PM_POINT_M 

 
 
and columns is selected so as to check/modify its parameters. 
 
 

 
 
 
Dialogue box in x and y text boxes shows equivalent dimensions of the square column. Enter 
slab thickness in the Slab Thickness text box. 
Support conditions of the point/column are entered in Support conditions tab. 
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Restrain vertical displacement of the point by checking the PZZ check box. 
With the purpose of calculating rotational stiffness, their dimensions and beam heads, if 
present, should be entered. Use Upper Column tab to apply these settings. 
 
 

 
 
 
 
 
Button Column  
 

 
 
and Column head. 
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Upper column can be replaced with rotational spring (check Rotational spring box), while 
lower column can be replaced with rotational and vertical spring (check the Rotational spring 
and Vertical spring check box). 
SOFiPLUS calculates spring values and they can be shown or edited in Spring x and Spring y 
tabs. 
 

 
or Spring z. 

 
If modifications in circle column characteristics are needed a message box may appear: 
 

 
 
This message pops up because by default this dialogue box opens as for rectangular column. 
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This error occur because y value for dimensions is 0. This error is eliminated by checking 
Circular in form field.  
When first column is entered Structural Point/Column command remains active and next 
structural points or columns can be entered.  
If Structural Point/Column dialogue box is necessary to be started several times, input data 
may be entered using following options: 
 

 
Save values into registry Data values are saved in the registry. 

 
Read values from registry Previous saved data are read from the registry. 

 
 

5.7 SUPPORTS 
 
By assumption, slab areas are formed as freely supported on boundary edges. Usually, 
additional modifications on slab boundary edges are required with the intention of releasing 
unnecessary restraints. Modifications can be done by: 
 

5.7.1 Info/Edit and Modify Structure Edge 
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In this example, inner slab area is supported only by columns (without beams). Therefore, 
displacements in Z direction of the inner edges should be released.   
For illustration purposes, both methods are shown. 
 

 

   ICON:        Info/Edit 
  MENU:       SOFiPLUS→Info/Edit... 
   Command: SOF_GINFO 

 
Select the edge to be modified. Edge can belong to different structural elements, so in the 
following dialogue box 
 

 
 
the right structural element to be modified may not be shown. For example, in this dialogue 
box information for one slab area are shown which has one equal edge with the selected 
edge. In such cases Next button is used to show the next selected edge. All subsequent 
elements are listed until desired edge information are shown. 
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Click on the Modify button to open Support conditions tab. Uncheck the PZZ check box 
 

 
 
and click on Apply to make changes on the edge.  
This method is used when structural element information or individual modifications of 
structural elements are needed. 
Whenever simultaneous modifications of several elements are required much better to use is 
the second method for alteration. 
 

 

   ICON:        Modify Structural Edges 
  MENU:       SOFiPLUS→Modify model→Structural Edges 
   Command: SOF_ SOF_PM_EDGE_M 

 
Select all structural edges to be modified. In the Structural edge dialogue box 
 

 
 
pick Support conditions tab and change PZZ input as previously described in Info/Edit 
command. 
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Staircase of the building is limited by two reinforced walls. Reinforced concrete beam is 
allocated with cross section: b/h=25/50 sm. 

  [] b/h = 25/50  
 
  
On the slab edge few modifications are necessary: to be replaced with beam and to allow 
displacements in Z direction. By Info/Edit or Modify Structural Edge command, select the 
edge. Support conditions are modified in Support conditions tab as previously described. 
After that open Beam tab, 
 

 
 
mark Cross section check box, Cross Section button becomes active and Cross Section 
dialogue box is opened, 
  

 
 
where clicking on New… starts the process for creating new cross section. Select Rectangle 
from the list  
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and enter beam cross section data. 
 

 
 
On edges slab are supported on reinforced concrete walls. Usually this way of supporting 
slabs is replaced with fixed supports. More accurate to use is elastic fixing where elastic 
stiffness of the support is equivalent to wall stiffness. 
Change in contour edge characteristics are done with Info/Edit or Modify Structural Edge 
command. To input wall characteristics open Upper Wall tab 
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and Button Wall 
 

 
 
and enter proper dimensions for Wall thickness, Wall Height and End fixity. 
If you click on Info/Edit command and select any edge beam you should see that rotational 
springs are entered along edge element length. 
 

 
 
 

5.8 FINITE ELEMENT MESH  
 
Three ways to define finite element mesh are possible. 
  
Automatic 
With objects 
With macros 
 
In this example first way to define finite element mash is used. 
 

 
   ICON:   Mesh Generation 
  MENU:  SOFiPLUS→Generate→Automatic mash generation 
   Command: SOF_G_MASHGEN 
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5.8.1 Maximum possible length of element’s edge 
Defines maximum element length. This length is used for automatic mesh generation. As 
default length, double value of the smallest geometrical distance is offered. Smaller elements 
are required around structural points (supports and short edges). 
NOTE: In order to calculate correct moments, one slab area should be approximated with at 
least 6 to 8 elements in any direction. 
 

5.8.2 Number of relaxation steps 
By selecting more relaxation steps, geometry of elements is improved. We should have in 
mind that every relaxation step spends a lot of computer time to calculate and we should 
select optimal number of relaxation steps. Usually 3 steps are enough for acceptable solution.   
 

5.8.3 Output 
When generating the mesh, output file may be created “Database_name.ER1” where 
numerical results are inputted. By checking certain check boxes you determine which data 
are inputted in the file. 
 

5.8.4 Page numbers 
Enters number of the first page. If check box is not marked, page numbering is not fulfilled.  
 

5.8.5 Activate 
If this check box is marked, mesh can be adjusted according selected load case. 
 

5.8.6 Band Width Optimization 
When mathematical model is created, node numbering is performed (shall not be 
sequentional numbering) and the program itself declares internal node numbers. Calculation 
speed depends on the difference between maximal and minimal number of nodes in the 
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element (band width). In order to increase the calculation speed renumbering of the internal 
nodes is carried out and smaller band width is acquired. 
 

5.9 STRUCTURE CONTROL 
 
Since finite element mesh is generated it is desirable to make visual control. Start the 
Animator.  
 

 
 
Check the structure using Animator tools. 
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5.10 IMPORT ANALYSIS DATABASE 
 
 
When generation is finished, finite element mesh is invisible to the user. If the mesh is 
required to be visible on the screen, analysis database should be imported.  
 

 
   ICON:   Import 
  MENU:  SOFiPLUS→Analysis Data Base (CDB)→Import (.cdb→.dwg) 
   Command: SOF_GENFIN 

 
Default name of the active database is entered in the Name text box. With the Browse… 
button other analysis database may be imported into the drawing. By marking or demarking 
check boxes a change in the imported database can be fulfilled. After closing this dialogue 
box, program reads finite element mesh and displays it into the drawing. Good control of the 
mesh is required as well as mesh density at singular points, points with concentrated loads 
and similar critical areas. Unless user is satisfied by automatic generated mash, certain 
adjustments have to be prepared in Control mesh generation dialogue box and finite element 
mesh generation process has to be repeated. Specific situations demand additional structural 
points, edges and etc. 
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5.11 ANALYSIS 
 

 
   ICON:   Analysis 
  MENU:  SOFiPLUS→Analysis... 
   Command: SOF_G_NUMOUT 

 
In the beginning analysis process requires to specify which output results are going to be 
computed. 
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By marking the check boxes certain options are activated. For example, to display reactions 
check the Load pattering check box. Static calculation is performed in WinPS working 
environment.  
 

 
 
WinPS working environment enables full control over the calculation process. Certain 
modules can be switched on or off. 
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By clicking on the Execute, analysis process of the structure starts. Particular error or warning 
signs appear in front of the module names signaling probable problems and abnormalities 
during execution. 
 

 
 
User should pay attention on the messages and analyze them with URSULA. 
 
 

5.12 GRAPHICAL PRESENTATION OF RESULTS 
 
SOFiPLUS disposes of powerful tools for graphical presentation of the results. One of the 
tools is GRAFICAL OUTPUT. 
 

 
   ICON:   Graphical Output 
  MENU:  SOFiPLUS→ Graphical Output→Graphical Output… 
   Command: SOF_G_GRAOUT 

 
When calling up this command offers two options. 
  

 
 
To start WINGRAF and iterative creation of drawing book, and 
All drawings are defined in advance and the book is automatically created. 
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In this example second option is picked (click on No). Graphical Output dialogue box contains 
couple tabs which allow appointment of particular drawing parameters for structure, 
deformations, static values and reinforcement.  
 
 

 
 
 
The first tab System serves for selecting of structural elements which are going to be 
displayed on the drawing. Also scale, paper layout, text size and starting page number is 
adjusted on this tab. 
Single Load Cases and Load Pattering tabs determine which static values are going to be 
drawn and the way they are going to be displayed (numbers, contours, colored surfaces). 
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The difference between them is in applying the options on all load case. Such case is Load 
Pattering and Single Load Case defines each load case separately.  
Reinforcement Design is used to define the mode of displaying reinforcement in slab 
elements. 
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When Graphical Output dialogue box is closed, WinGRAF module is started automatically 
and drawing book is created. When WinGRAF finishes the procedure, URSULA is started and 
allows review of the drawings. 
 

 
 
URSULA working environment is divided on two parts. In the left part contents of the book is 
shown and on the right part selected page in the list is displayed. 
 
 

5.13 VIEW AND  PRINT RESULTS 
 
SOFiPLUS creates several resultant files. Review of the files can be done by the following 
command:  
 

 

   ICON: View and print 
  MENI:  SOFiPLUS→ Tools→View and print 
   Command: SOF_G_TYPED 

 
In the file list select the file you want to review or print. 
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For example, if you select BASEMENT_MSH.ERG file, finite element mesh file data is 
opened. 
 

 
 
Other files in this example are: 
 
BASEMENT_LFD.ERG – load data 
BASEMENT_SLA.ERG – load coefficient data  
BASEMENT_STB.ERG – beam dimensioning data 
  
It is interesting to make a comparison between different models of a structure. To be able to 
see the differences between models the same slab structure is examined, but the columns 
are molded with point supports and the reinforce concrete walls with fixed supports. To 
indicate other SOFiPLUS possibilities few changes in molding the slab around staircase are 
made. 
First by command: 
 

 

ICON:       1/3 Line 
        MENU:     Soils→Defined model→Auxiliary Line→1/3 Line 
Command: SOF_DRITTEL-LINIE 

 
structural lines of inner walls of the slab are drawn. 
Those structural lines are placed on layer: X__AUFL 
 

 
 
With AutoCAD command Line lines are drawn between columns and between columns and 
walls. Those lines, using AutoCAD command Match Property or using the command:  
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    ICON:     Copy to structural Layer 
   MENU:     SOFiPLUS→Defined model→Auxiliary Line→S Copy to            
structural Layer 
    Command:  SOF_DRITTEL_LINIE 

 
are transferred on layer X__AUFL and are transformed in structural lines. 
 

 
By the command: 
 

 

    ICON:         Structure area 
   MENU:        SOFiPLUS→Defined model→Structure area 
    Command:  SOF_PM_AREA 

 
structural areas are created and by the command: 
 

 

    ICON:         Opening 
   MENU:        SOFiPLUS→Defined model→ Opening    
    Command:  SOF_PM_HOLE 

 
opening in the center of the slab are formed. Thereby parameters for the slab and loads are 
entered: Geometry (d=18 cm) and Loads (Dead load 1.5 kN/m2 and Impulse load 3.5 kN/m2).  
In the next steps several modifications of the area 8 are made, with the purpose of adapting it 
according the staircase.  
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First two edge lines are going to be divided on two parts. 
 

 

    ICON:          Split edge 
   MENU:        SOFiPLUS→Modify model→ Split edge 
    Command:  SOF_M_EDGE_SPLIT 

 
Command: SOF_M_EDGE_SPLIT 
structural edge (end+mid+int+nea): mid 
of 
pick Point on edge (end+mid+int+nea) or [First point]: mid 
structural edge (end+mid+int+nea): Return 
 
As a result structural edge is divided on two parts and at intersection point new structural 
point is inserted. Likewise, outward structural edge is divided on two parts. New structural 
edge is drawn, connecting both new created points. 
 

 

    ICON:          Structural edge 
   MENU:         SOFiPLUS→Define model→Structural edge 
    Command:  SOF_PM_EDGE 

 
 
This new structural edge divides area 8on two parts. SOFiPLUS recognizes new closed 
contours and transforms them in structural areas. Loads on Areas dialogue box is opened 
automatically to enter loads for the new area. 
 
 

 
 
 
Starting the command SOF_PM_EDGE a dialogue box opens and new characteristics of 
edge lines are entered. This line should represent fixed support or support which can accept 
vertical reaction and moment. To input these characteristics open Support conditions tab and 
mark boxes in front of PZZ and MX. 
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Area 8 is supernumerary. There is no slab in that area and it should be deleted. Deletion is 
done by simple AutoCAD command Erase. One more modification has to be done. Lower 
edge lines of areas 9 and 10 should be moved to adjust on the architecture of the structure. 
 

 
 
Use AutoCAD command Stretch to move point P1 to P2. 
 



 
 
 

 
5-131        SOFiPLUS_Tutorial_IGH.docf 

 
 
When slab areas are formed, edges are freely supported. 

 
 
In this example, inner edges should be restrained from displacement in Z direction and 
contour edges should be transformed in fixed supports. 
 

 

   ICON:        Modify Structural Edges 
  MENU:         SOFiPLUS→Modify model→Structural Edges 
   Command: SOF_PM_EDGE_M 

 
First select the inner edges and check the PZZ box. 
 

 
 
In the next step contour edges are transformed as fixed. 
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At the end edge between inner reinforced concrete walls is replaced by reinforced concrete 
beam with cross section ([] b/h = 25/50). 
 

 
 
Further columns has to be entered. As stated before, in this example, columns are replaced 
with point supports (restrained displacement in Z direction). 
 

 

   ICON:    Modify Node 
  MENU:   SOFiPLUS→Modify finite element→Node 
   Command: SOF_GKNOTMOD 

 
Select support nodes and in the Support conditions tab check PZ box to restrain 
displacement. 
 

 
 
Final look of the mathematical model is shown in this picture. 
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The remaining steps in the analysis (finite element mesh generation, analysis, graphical 
presentation of the results) are the same as previous model and are not repeated here. 
Typical differences in both models are in points above columns and contour edges. 
Therefore, make two sections through these points and compare the results. Results are 
graphically presented in WinGRAF. 
 

 

ICON:  WinGraf 
MENU:  SOFiPLUS→Graphical output→Graphical  Output…  
Command:  

  
Start new sheet in WinGRAF. 
 

 
ICON:  New Sheet 
MENU:            Edit→New Sheet 

 
On the new sheet structure contours with supports are drawn. Draw two cut lines to view 
bending moments.  
 

 

ICON:  Create Cut 
MENU:            Edit→Cuts→Create 

 
Command: 
Create cuts above Area Element 
From point: (Click on the first point of the line) 
To point:  (Click on the last point of the line) 
 
Two lines are drawn: first passes above the column and the second between columns. 
Results are drawn using following command: 
 

 
ICON:  Draw Results 
MENU:           Select→ Draw Results… 

 
 
In the dialogue box select: 
 



 
 
 

 
5-134        SOFiPLUS_Tutorial_IGH.docf 

 
 
Element  Area elements 
Resultgroup  Forces 
Resulttype  Bending moment m-nn 
Representation Filled Cut 
Loadcase  1: Dead load 
 
Normal moments are drawn on the sheet. To get the best view zoom the area around lines.  
 
 

 
ICON:  Box 
MENU:            Select→ Box 

 
 
Command: 
Choose Box.1 Corner: (Draw rectangle to represent new view port on the drawing) 

 
 

Bending moments along both cut lines for both models are presented: 
 
 
 
Columns molded with elastic springs: 
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Columns molded with point supports: 
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Twice dense finite element mesh:  
 
Columns molded with elastic springs: 
 

 
 
 
Columns molded with point supports: 
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COMMENT: Model with the elastic springs shows lower dependence from mesh density. At 
point model, owing singularity of the moments, moment values at supports are increasing as 
far as finite element size is decreasing.   
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6. Example 3 : Platform II 
 
This is a further extension of EXAMPLE 2: 
 
 
Geometry of platform II is shown on following sketches. 

 
 
Central part has girder-less roofing supported on circle columns. Roofing on its contours is 
supported on reinforced concrete beams placed over rectangular columns. Central part of the 
slab has circle opening. Staircase area is designed as Platform I. 
 

6.1 AutoCAD preparation 
 
Finite element mesh will be created by AutoCAD objects. For this purpose user should 
knowledge about have basic AutoCAD functions for creating 3D surfaces. Main purpose of 
this example is to present SOFiPLUS possibilities without taking care about optimal solution 
and critical attention to finite element mesh.  
It is recommended to create several auxiliary layers for lines, surfaces and etc. This style in 
preparation process, provides bigger control over the drawing.  
Several auxiliary lines are drawn in this preparation phase. This lines should create closed 
rectangular areas (rectangular edges may not be straight). They are placed on layer named 
POMOSEN. 3D surface is created for each element. In this example following AutoCAD 
command is used: 
  

 

ICON:    Edge surface 
        MENU:     Draw→Surface→ Edge surface 
Command: RULESURF 
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This command creates surface by moving one line over two other lines. This command has 
two variables: TUBSURF 1 and TUBSURF 2. This variables define mesh density in both slab 
directions. 
 

 
 
In the applied method for creating finite element mesh, size of the variables defines mesh 
density. 
First finite element mesh for central array is generated. Divided parts have density of 9 parts 
in longitudinal and transverse direction.  
 
Command: SURFTAB1 
Enter new value for SURFTAB1 <8>: 9 
Command: SURFTAB2 
Enter new value for SURFTAB2 <2>: 8 
 
Now, generation of surface is done. Surface edge selection schedule is shown on the picture.  
 

 
Command: _edgesurf 
Current wire frame density:  SURFTAB1=9  SURFTAB2=8 
Select object 1 for surface edge: (click on point P1) 
Select object 2 for surface edge: (click on point P2) 
Select object 3 for surface edge: (click on point P3) 
Select object 4 for surface edge: (click on point P4) 
 
First surface has been created. 
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In the next step second surface over the lower beam is formed. You should be careful on the 
edge division number which merge to remain the same. Thus, same division of parts are used 
in longitudinal direction and only variable that defines divisions in transverse direction of the 
beam is changed. (minimal possible number 2 is used). 
 
Command: SURFTAB2 
Enter new value for SURFTAB2 <8>: 2 
 
Surface edge selection plan is shown on this picture. 
 

Second surface has been created. 

 

 

This process continues until all characteristic surfaces of the segment are created. 
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Base segment is regular octagon, created from eight equivalent segments. The remaining 
segments of the slab will be formed by copying them with circle array. 
 

 

ICONA:    Array 
        MENU:     Modify→Array 
Command: Array 

 
Command: array 
Select objects: 1 found 
Select objects: 1 found, 2 total 
………… (select all surface segments) 
Select objects: Return 
Enter the type of array [Rectangular/Polar] <R>: P 
 
Specify center point of array: _cen of 
Enter the number of items in the array: 8 
Specify the angle to fill (+=ccw, -=cw) <360>: Return 
 
Rotate arrayed objects? [Yes/No] <Y>: Return 
 
RECOMMENDATION: It is useful to close all layers except surface and central circle layer, 
before using Array command. Auxiliary lines should be precisely drawn, so inspected 
segment is supposed to represent 1/8 of circle. 
As a result of Array command whole central surface is covered with surfaces. 
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6.2 CREATION OF FINITE ELEMENT MESH 
 
Finite element mesh is created by using AutoCAD objects (surfaces): 
 

 

ICONA:    Generate with objects 
        MENU:     SOFiPLUS→Generate→With Objects  
Command: SOF_GNETGEN 

 
In the dialogue box 
 

 
 
select QUAD (quadrilateral area elements are generated). If you specify value for Minimum 
edge length, only smallest element size is will be defined. This is usually used for filtration, in 
case some small elements are not supposed to be taken in the mesh. Created elements may 
be located in a groups (Group No. option). Break entities on intersection should be checked in 
order to acquire line intersection nodes. Program itself searches for intersection nodes on 
lines, arches and polygonal lines, generates node points and creates finite elements between 
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these node points. Merging lines are not taken under consideration. A message like this pops 
up, 
  

 
 
to determine if polygonal lines and meshes are going to be deleted from selected set (answer 
Yes). Generation is finished after answering the question about first element number to be 
generated with this task. 
 
Select objects: 
...................................................... 
First Element number<1>: Return 
 
Searching intersections .... 
Treating partial-lines ... 
Making Elements ... 
 
 

6.3 CREATING FINITE ELEMENT MESH USING MACROS 
 
SOFiPLUS offers several possibilities for creating finite element mesh using macros. 
Quadrilateral areas can be created combining different lines and points. 

 
Positive side in generating finite element mesh using macros is creating the mesh directly 
without using auxiliary lines. Node points which are previously generated on edges, are 
recognized by a macro and for those edges information about number of elements are not 
needed.   
 

 

ICON:    1/3 Line 
        MENU:    SOFiPLUS →Generate→With Macros 
Command: SOF_G_DOL 
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With this command user can create quadrilateral, beam, truss or cable elements. Selection is 
done in the dialogue box which is called up after this command. 
 

 
 
In this example, slab system is examined, therefore TRUSS (Truss beam elements) and 
ROPE (Cable elements) are not available. First finite element mesh is created in the slab area 
which lies over the column using the option 4Lines. 
 
Command: 
Determine input order <4Lines>[4Lines/3Lines/2Lines/1Pt 2lines/2Pts  
1line/4Points/Element type/Help...]: 
 
1. Pick line: (select first column line) 
2. Pick line:  (select second column line) 
3. Pick line:  (select third column line) 
4. Pick line:  (select fourth column line) 
 
If lines are selected correctly, SOFiPLUS marks the contour 
 

 
 
and asks user for verification of desired geometry: 
 
Geometry as desired? [<Yes>/No]: Y 
 
In the next step mark the rectangle edge to input number of elements to be created on the 
edge. In this example, one element is adopted for the first edge. 
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Enter number of elements: 1 
 
Next edge is marked to input number of elements. 

 
Enter two elements for this edge. 
 
Enter number of elements<1>: 2 
 
Enter number of the elements for the remaining two edges. After that SOFiPLUS displays 
messages to enter odd and even number of elements. 
 
Enter odd number of elements<1>: Return 
Enter even number of elements<2>: Return 
 
At the end enter the first element number from the group to be created. 
 
First Element number<1763>: Return 
 
Mesh created for the selected edges is shown on the following draft. 
 

 
Finite element mesh for beam element is also created by macro command. Other option is 
used: 2Lines 
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Command: 
Determine input order <4Lines>[4Lines/3Lines/2Lines/1Pt 2lines/2Pts  
1line/4Points/Element type/Help...]: 2L 
 
1. Pick line: (select upper beam edge) 
2. Pick line: (select downward beam edge) 
Geometry as desired? [<Yes>/No]: Y 
Enter number of elements<6>: 6 (number of elements of the upper edge)  
Enter even number of elements<6>: (number of elements of the downward edge)  
 
In this case SOFiPLUS recognizes previously defined elements on other two edges and 
accepts that number. 
 
First Element number<1765>: 
 

 
 
Finite element mesh in other parts of the structure can be created by objects or macros. This 
procedure is already described in previous lines, so only final look of the mesh is presented. 
 

 
 
 
 
 

6.4 CORRECTIONS IN FINAL ELEMENT MESH 
 
In the actual structure opening is present in the center, where staircase is situated. In the 
mathematical model finial elements in that area have to be erased. Deletion is done by simple 
AutoCAD command Erase. Click on the Erase button and click to select all elements to be 
erased. After deletion mathematical model looks like the one on the picture. 
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During finite element mesh creation, on few edges elements of neighboring areas do not 
match.  
 
 

 
 
 
Points from both meshes have to be compatible. For this purpose, AutoCAD commands Move 
and Stretch are used. First move the points P1, P2 and P3 to match points P1 and P4. 
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On the same way points from the slab where no matching of elements on neighboring areas 
are present, are modified. 
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6.5 CONSTRAINTS 
 
CONSTRAINTS stands for connecting several points to reference point, so that points have 
same deformation as reference point. In this example points from the contour are connected 
with the point in the center of the column (reference point). 
 

 
 
 

 

ICON:    Constraint 
         MENU:    SOFiPLUS→Create Finite Element→Constraint 
Command: SOF_GKOPP 

 
Command: 
nodes to couple 
Select objects: (select contour points of the column) 
Reference node (end+cen+nod+int+ext): (select center point of the column) 
Type of constraint [KPZ/KMX/KMY/KP/KL/KQ/KF]: KP 
  (KP match by all deformations of the slab) 
nodes to couple 
Select objects: (continue with other points where CONSTRAINTS has to be entered) 
 

 
 
During finite element mesh creation with commands Generate With Objects or Generate With 
Macro, node points in the mesh are freely supported. Displacement of the reference point on 
the column should be restrained. Use Modify Node or Info/Edit. In this example first command 
is used. 
 

 

ICON:    Modify Node 
         MENU:    SOFiPLUS→Modify Finite Element→Modify Node 
Command: SOF_GKNOTMOD 

 
 
 
In the following dialogue box 



 
 
 

 
6-150        SOFiPLUS_Tutorial_IGH.docf 

 

 
 
mark PZ check box to restraint node to move in Z direction, namely to accept vertical 
reaction. 
When reference point is set, it can be deleted from the drawing. If reference point is not 
already created, you can create it with previous command. 
 

 

New created point  

By doing this, deformations for contours are connected with center points of the columns in 
the structure. 
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6.6 BOUNDARY ELEMENTS 
 
Boundary elements are used for line supports. User enters first and last point of the line 
support. Automatically all nodes which lay on that line are recognized by the program and 
prescribed deformations are applied. If line supports have to be entered on circle arch, nodes 
are entered one by one. 
 

 

ICON:  Boundary Element 
        MENU:  SOFiPLUS→Create Finite Element→Boundary    element 
Command: SOF_GRAND 

 
Command: 
First node of boundary element (end+mid+nod+int):  
 (click on point R1) 
Last node of straight boundary element (end+mid+nod+int):  (click on point R21) 
Support direction [CZ/DX/DY/DN/DT]: DN 
Spring constant at start in kN: 15000 
 (Rotational stiffness of the wall in point R1) 
Spring constant at end   in kN<15000.0000>: 
 (Rotational stiffness of the wall in point R2) 
Name of boundary element: Bound1 
Connect found intermediate node? [<Yes>/No]: y 
Select additional intermediate nodes 
 (additional nodes are not entered) 
First Boundary element No.<1>: 
First node of boundary element (end+mid+nod+int): Return 
Refer. point (end): Return 
 
Few types of constraints of the contour elements are possible: 
 

 
 
If Name of boundary element is not entered, program inputs blank name to avoid errors in 
static program. All reactions contained in this line support in the program for static calculation 
are distributed along support length. 
Line support for second wall at the staircase is created on same way. 
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Constraint type DN creates elastic rotation along the line. Limited vertical displacement 
should be added to this displacements. Using Info/Edit or Modify node vertical displacement 
in nodes along the line support should be constrained.  
 
 

6.7 BEAM ELEMENTS  
 
On the outward contour of the hallway, slab is supported on beams. Those beams have to be 
entered in the model. 
 

 

ICON:  Beam 
         MENU:  SOFiPLUS→Create Finite Element→Beam 
Command: SOF_GSTAB 

 
Command: 
Start node (end+mid+nod+int): (Start node of the beam) 
End node (end+mid+nod+int): (End node of the beam) 
Connect marked intermediate node? [<Yes>/No]: Y 
(Intermediate points between start and end node are recognized by the program) 
First Beam No.<1>: 1 
Section number<1>: 2 
 
Start node (end+mid+nod+int): (Continue with other beams) 
 
 
Beam elements passing above outward columns in central slab are created in the same 
manner.  
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6.8 MODIFYNG THICKNESS OF AREA ELEMENTS  
 
Area elements created by objects or macros have equal thickness as assumed (in this 
example 20 cm). Usually this thickness is not equivalent to real and should be changed. 
Modification is done using Modify Area Element or Modify Area Element Variable. First 
command is used whenever modification is permanent at whole selected slab area and the 
second command when slab has variable characteristics (variable thickness, placenta and 
etc). In this example, slab thickness should be changed to 18 cm. 
 

 

ICON:  Modify Area Element 
        MENU:  SOFiPLUS→Modify Finite Element→Area Element 
Command: SOF_GQUADMOD 

 
After activating this command, elements to be modified have to be selected. In the example, 
select all area elements. After selection, enter slab thickness 0.18 m in Dim edit box. 
 

 
 
To control input data use following command: 
 

 

ICON:  Info/Edit 
        MENU:  SOFiPLUS→Info/Edit… 
Command: SOF_GINFO 

 
to display element information for clicked area.  
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6.9 LOADING 
 
During finite element mesh generation by objects or macros, load cases are not automatically 
created. First use Loadcase Manager to define load cases and then apply all loads acting on 
the slab. 
 

 
ICON:  Loadcase Manager 
MENU:  SOFiPLUS→ Loadcase Manager  
Command: SOF_GLFMOD 

 
Two load cases are analyzed.  
 

 
 
Enter SW factor 1.00 for the first load case. It indicates that for this load case self weight of 
elements is automatically calculated and participates 100% in defining loads. As a result of 
other loads which act on the slab, it should be loaded with additional load of 2.00 kN/m2. To 
enter this load, make first load current in Loadcase Manager. Select first load case and click 
on Current button. 
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ICON:  Free Area 
MENU:  SOFiPLUS→Create Loads→Free Area  
Command: SOF_GBLAS 

 
Enter load parameters in the dialogue box. 
 

 
 
U.D.L. (Uniform Distributed Load) check box is marked so load is uniformly distributed. In the 
edit text box enter load value 2.00 kN/m2. Select load direction in Loadtype combo box as 
gravity direction. Pick for nodes on the screen to form rectangular area which covers the part 
of the slab to be loaded. Area may go out of the slab contours and the program automatically 
computes loads on area elements. 
 

 
 
To retain visual control over the process, loading area is hatched. Load area is drawn on 
layer: X__B001_PLATFORMA II. To preserve bigger visual control over the loading areas it is 
desirable to close this layer before other loadings are entered for the second load case.  
For the second load case two uniform loads are entered. Central part is loaded with 7.00 
kN/m2 and the staircase are with 4.00 kN/m2. Make second load case current from the 
Loadcase Manager. Activate Create Loads→Free Area and enter load parameters. 
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Command: 
pick 1 cornerpoint (end+mid+nod+int) or [Enter polygon]: e 
 (Loading area is polygonal) 
pick 1 cornerpoint (end+mid+nod+int): (First polygon point) 
pick 2 cornerpoint (end+mid+nod+int) or [Undo]: (Second point) 
(click all polygon points) 
Refer. point (end): Return 
 

 
 
Central part is loaded with uniform distributed load with intensity 7.00 kN/2. Enter hallway load 
on the same way. 
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Staircase transport line load on the slab with intensity of 10.00 kN/m2.   
 

 

ICON:  Free Line 
MENU:  SOFiPLUS→Create Loads→Free Line  
Command: SOF_GLLAS 

 
Enter load parameters on similar style as for area loads. 
 

 
 
Line load is placed on polygon which covers circle arch at staircase area. 
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Loads from the second load case are drawn on the layer: X_B001_PLATFORMA II. 
 

6.10 EXPORTING DATABASE 
 
Before running the calculation, element and load data have to be saved in the analysis 
database. It may be good idea to control database for complex structures. 
 

 

ICON:  Export 
MENU:  SOFiPLUS→Analyze Data Base (CDB)→Export (.dwg→.cdb) 
Command: SOF_GENFIN 

 
During control some mistakes are eliminated. For example node duplication, deleted nodes 
from elements are retrieved and etc. 
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After control is accomplished, database is exported again. Drawing data are placed into the 
analysis database and ready for further processing. 
 
 

6.11 ANIMATOR 
 
It is advisable to run visual control of the structure before analysis is performed. 
 

 

ICON:  Animator 
Command: Animator 

 
When visual check is under progress, pay special attention on supports. 
 

 
 
From this control it is obvious that displacements of two columns are not correctly assigned in 
the mathematical model. Make necessary corrections in SOFiPLUS. Activate following 
command: 
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ICON:  Info/Edit 
         MENU:  SOFiPLUS→Info/Edit… 
Command: SOF_GINFO 

 
Select node which is modified. 
 

 
 
Enter the modification in the dialogue box. Program may not recognize this node point. Click 
on the Next to display all objects which contain selected point. When node is displayed in the 
dialogue box make the change, 
 

 
 
by clicking on Modify and enter the changes in the dialogue box. 
 

 



 
 
 

 
6-161        SOFiPLUS_Tutorial_IGH.docf 

 
This process continues by changing the characteristics for the second node which has wrong 
displacements. 
After this changes you have to export analysis database again. 
 
 

6.12 STUCTURE ANALYSIS 
 
Analysis is performed in program WTEDY. 
 

 

ICON:            Edit (Win Ted) 
MENU: SOFiPLUS→Analysis … 
Command: SOF_G 

 
Enter the file name in the next dialogue box. 
 

 
 
 
Working area of the Teddy program is displayed on the screen. Any additional data for the 
analysis which are not contained in SOFiPLUS may be entered. For this example all 
proposed options are accepted. 
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Start the program WinPs to begin with the analysis. You have full control over the 
computation process in WinPs. 
 

 
 
Icon Execute starts the calculation. If this process finishes without errors, output data files 
may be created. 

  
 
URSULA 
 is used to create output files which contain text and graphic presentation of the results. File 
contents are predefined. Its contents may be rearranged with friendly Teddy instructions. This 



 
 
 

 
6-163        SOFiPLUS_Tutorial_IGH.docf 

files can not be modified after the analysis. Preview of the files can be done by selecting the 
file in the left pane of the Explorer. 
 

 
 
For fast preview of the results, without creation of output files, use Animator and its tools for 
different visual views. 
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7. Example 4 :ROOF STRUCTURE 
 
Roof structure is consisted of 16 parabolic-hyperbolic segments. The segments are formed by 
elevating one point from the base for 1 meter. On edges segments are supported by edge 
beams (b/h=30/30). Central part of the structure represents annular slab. Story height is 4 
meters. Central columns are circular with diameter d=40 cm, while ending columns are 
rectangular with dimensions of the cross section b/h=40/40 cm. 
 

 
 

7.1 AutoCAD PREPARATION 
 
First we should make a three-dimensional drawing of the structure. After that three-
dimensional surfaces have to be created. For drawing the surfaces several AutoCAD 
commands may be used: Edge Surface or 3D Mesh. If you create the finite element mesh by 
macros, mesh generation may be exuded. In order to create finite element mesh for the 
annular slab, two structural lines should be drawn. 
 

 
 
To enable better visual control, three layers should be created: Axis - for structural lines, 
Construction - for structure contours and Meshes - for wire models of 3D surfaces of the 
structure. 3D surfaces can be created on all areas of the structure or on one characteristic 
area and copied in circle raster mesh by using Array command. In this example, the 
mentioned styles for creating the meshes above are not preferred but techniques which 
depend on the users style. 
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To gain better visual control of the drawing it is desirable to view it from three view ports.  
Command: vports 
Enter an option [Save/Restore/Delete/Join/SIngle/?/2/3/4] <3>: 3 
Enter a configuration option [Horizontal/Vertical/Above/Below/Left/Right]  
<Right>: L 
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7.2 STRUCTURAL SYSTEM 
 
Structural model of this example is Space model. Analysis will be proceeded under EuroCode 
(EC 2) standards. Structural system is set by:   
 

 

ICON:              Structural system 
MENU:   SOFiPLUS →Structural system… 
Command:   SOF_GSYSMOD 

 

 
 
Input parameters for the structural system and database are: 
 
Project Roof construction 
Database PlatformRoof 
Orientation of Self 
Weight: 

Pos. Z axis 
 

Maximum number of 
element per group 

10000 
 

Point size 0.05 
Structural mode Space 
Database coordinate 
system 

SOFiSTiK 
 

Drawing units m 
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7.3 MATERIAL 
 
Slab material is concrete 35. 
 

 

ICON:            Material 
 MENU: SOFiPLUS →Defined model→Material 
Command: SOF_GSYMATE 

 
Default materials are used: 
 
Standard Concrete S35 (EC 2) 
Standard Reinforcing Steel S500 (EC 2) 
 

 
 

7.4 CROSS SECTIONS 
 
Three types of cross sections are used in this example: rectangular (b/h=30/30 cm), square 
(b/h=40/40 cm) and circular (d=40 cm). 
 

 

ICON:            Cross Section 
 MENU: SOFiPLUS →Defined model→Cross Section 
Command: SOF_GQUER 

 
In the dialogue box click on New button. 

 
Select Rectangle cross section from the list. 
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and enter cross section data for edge beams. 
 

 
 
Continue entering cross section data as explained before. 
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7.5 FINITE ELEMENT MESH 
 
Finite element mesh can be created by objects or by macros. In this example, it is much 
simpler to generate finite element mesh by objects. Mesh is already generated by AutoCAD 
commands and should be selected and converted in finite element mesh. The best way to do 
this is to use second drawing projection. Select the upper part of the structure using Select 
Window. 
 

 
 
It is recommended to turn off all layers except layer with surface meshes. 
 

 

ICON:  Generate with Objects 
 MENU: SOFiPLUS →Generate→With Objects 
Command: SOF_GNETGEN 

 

 
 
After selecting the roof structure, on the following question: 
 
First Element number<1>: 1 
 
enter number of the first element in the selected group (1). 
 
 

7.6 FINITE ELEMENT MODIFICATIONS 
 
Slab elements created by objects are formed with thickness equal to assumed (20 cm). In the 
example, thickness of the shell elements is 8 cm and circle annular slab has thickness 16 cm. 
Modification of the finite element thickness is necessary. Change is done by command Modify 
Area Element or Modify Area Element Variable. As previously explained, first commands is 
used whenever modification is permanent along whole selected slab area while second 
command is used when slab has variable characteristics (variable thickness, etc). To change 
the thickness in this example first command is used.  
 

 

ICON:          Modify Area Element 
        MENU:        SOFiPLUS→Modify Finite Element→Area Element 
Command:   SOF_GQUADMOD 
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Select all element which will be changed. In this example select all shell elements. After 
selection, in the following dialogue box 
 

 
 
enter slab thickness 0.10 m in the edit text box Dim. Change the annular slab thickness as 
performed before. (d=0.16 m) 
 

 

ICON:           Info/Edit 
        MENU:         SOFiPLUS→Info/Edit… 
Command:   SOF_GINFO 

 
If you click with the mouse inside any element area, information about element are presented 
as on the picture. 

 
 

7.7 EDGE BEAMS 
 
Whenever structural model is consisted of combination of beam and area/shell elements, 
attention should be paid on generation schedule. First, area/shell element mesh should be 
formed and then beam element mesh. At this sequence SOFiPLUS easily recognizes nodes 
on the mesh which lie on beam axes. This parts are dived on segments, so beams and area 
element have same nodes. 
Activate Beam command.   
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ICON:         Beam 
        MENU:       SOFiPLUS→Create Finite Element→Beam 
Command: SOF_GSTAB 

Command: 
Start node (end+mid+nod+int): (First beam node) 
End node (end+mid+nod+int): (End beam node) 
Rotation of y-axis <0> or [Xx/Yy/Zz/Negx/nEgy/neGz]:Return 
 
Connect marked intermediate node? [<Yes>/No]: Y 
(Program recognizes inter-nodes which lie between first and end node, and if you answer with 
Y on the question, nodes are temporary marked. With this action easier control of the beam 
element generation is enabled). 
 

 
 
First Beam No.<1>: 1 
Section number<1>: 1 
 
Start node (end+mid+nod+int): (Continue with next beams) 
 
All beam elements are generated as stated before. 

 

7.8 COLUMNS 
 
In this example two types of columns are used: circle and square. For circle columns position 
of the local Y-axis is not important, while at square columns you should be careful because 
they are in rotating position so Y-axis has different orientation of the columns. Firstly circle 
columns are generated. Columns are beam elements formed with Beam command. 
Generation method is previously explained and will not be repeated here. 
 
Command: 
Start node (end+mid+nod+int): (Start column node) 
End node (end+mid+nod+int): (End column node) 
Rotation of y-axis <0> or [Xx/Yy/Zz/Negx/nEgy/neGz]:Return 
marked intermediate node? [<Yes>/No]: Y 
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First Beam No.<1>: 256 
Section number<1>: 3 
 
Start node (end+mid+nod+int): (continue with next circle column) 
 
Rectangular columns are formed by same method. Difference is in section number (2) so, 
now for every column, orientation of the Y-axis should be entered. 

 
Proposed procedure for creating finite element mesh is not general. If user is familiar with 
AutoCAD, he may find out more adequate work styles. For example, observed structure is 
formed by 8 equal segments. Instead creating finite element mesh for whole structure, mesh 
can be formed on one segment. 

 
 
 
 
By using AutoCAD command Copy Array (polar), other segments are created. This way is 
simpler because at copying process, option: rotate object as copied is involved and 
adjustment of the local Y-axis of columns is automatically executed. 
This approach requires special attention. Finite element meshes have to concur ideally. 
Having in mind that AutoCAD disposes of great number of tools for precise positioning this 
correspondence is not a problem. When SOFiPLUS copies segments, it does not 
automatically enters new node points. Therefore this type of generated mesh is liable to 
regular controls. 
 

 
   ICON:   Import 
  MENU:  SOFiPLUS→Analysis Data Base (CDB)→Import (.cdb→.dwg) 
   Command: SOF_GENFIN 

 
In the dialogue box, select the option: Check run (no output). As stated before in the text, this 
Command eliminates errors according as node duplication, deletion of nodes connected to 
elements and etc.  
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7.9 LOADING 
 
At finite element mesh generation process by objects and macros, load cases are not 
automatically created. Firstly define load cases using Loadcase Manager  and afterward 
apply the loads which act on the slab.  
 

 
ICON:  Loadcase Manager 
MENU:   SOFiPLUS→ Loadcase Manager  
Command: SOF_GLFMOD 

 
Two load cases will be analyzed. 

 
 
Enter SW 1.00 for the first load case. It denotes that self weight of the elements is 
automatically calculated in this load case and participates 100%. As a result of other dead 
loads, the whole slab should be loaded with load of 2.00 kN/m2. To input this load in the 
computation, first in Loadcase Manager make the first load as current. Select the first load 
case and click on the Current command button.   
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ICON:         Free Area 
MENU:       SOFiPLUS→Create Loads→Free Area  
Command: SOF_GBLAS 

 
Enter load attributes in the following dialogue box. 
 

 
 
U.D.L. (Uniform Distributed Load) check box is marked which specifies that load is uniformly 
distributed. In the edit box enter load value 2.00 kN/m2. For Loadtype pick Load in gravity 
direction to define load direction. Pick four nodes on the screen which form square area and 
cover the part of the slab area to transfer loads. This area may come out of the slab contours, 
so the program automatically calculates certain loads on area elements. 

 
 
To have better visual control of the process, loading area is hatched. Loading area of the slab 
is drawn on the layer: X__B001_ROOFCONSTRUCTION. To obtain greater visual control 
over the loading areas it is desirable to close this layer, before entering loads for the second 
load case. 
In order to illustrate other possibility for entering loads, small modification in the finite element 
properties from annular slab is created. All its finite elements are placed in group 1. 
 

 

ICON:  Modify Area Element 
        MENU:   SOFiPLUS→Modify Finite Element→Area Element 
Command: SOF_GQUADMOD 

 
Select the elements from the annular slab. 
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In the edit box Group No. enter group 1. Since maximal number of elements in one group is 
appointed to 10000 (Structural system …), numbering of the elements starts from 10000. 
In the second load case two distributed load act on the slab: central part is loaded with 7.00 
kN/m2 whilst hallway is loaded with 4.00 kN/m2. Make the second load case current by using 
Loadcase Manager. Trigger command Create Loads→Free Area and enter load parameters. 
 

 
 
At entering the second load case load distribution is conducted according the group of 
member elements. 
 
 Reference Type   QGRP – Group Quadrilateral Element 
 
Click to clear ALL (Group/reference Type) check box and enter the group on which load 0 
acts.  
 
 Direction of projection ELEM – projection 
 
Load acts along element projection perpendicular to load direction (PZZ – global load Z). 
 
 Tolerance width  5 
 
This reference defines depth for the load. All QUAD elements on distance +/- 5 m from the 
loading area will be loaded with prescribed load. 
First load for shell elements is entered with value of 7.00 kN/m2. 
 
Command: 
pick 1 cornerpoint (end+mid+nod+int) or [Enter polygon]: e 
 (Loading area is polygon) 
pick 1 cornerpoint (end+mid+nod+int): (First polygon node) 
pick 2 cornerpoint (end+mid+nod+int) or [Undo]: (Second ) 
pick 3 cornerpoint (end+mid+nod+int) or [Undo]: (Third) 
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pick 4 cornerpoint (end+mid+nod+int) or [Undo]: (Fourth) 
 
 

 
 
Repeat this process for the central annular slab. Its area is loaded with uniformly distributed 
load of 4.00 kN/m2 and it elements are in group 1. 
 

 
 
Loading area may be same as in the previous case. 
Analysis database exportation and analysis process are same as in the other examples and 
are not presented here. 
 

 
 
 
 
 



 
 
 

 
8-177        SOFiPLUS_Tutorial_IGH.docf 

 

8. Space Analysis of the building 
 
In previous chapters specific floors of a building were under observation. Using 2D analysis 
static values in area and beam elements of the entresols were calculated. In continuance, the 
same structure is reviewed, as overall or space structure. Proposed methodology is only one 
of the possible solutions. Purpose of this example is to present AutoCAD and SOFiPLUS 
capabilities, not to give critical mark of the structural solution namely mathematical model. 
First make a drawing of the building with entered all characteristic plans of the building. For 
easier manipulation, separate plans are placed on different layers. 
 

 
 
 
 
Concept of the analysis is as follows: 
 
For every characteristic platform make mathematical model (finite element mesh/loads); 
Put all platforms in their positions in the structure (Move/Copy); 
Connect platforms by columns and walls; 
Enter supports; 
Enter additional loads which are not previously entered in the separate platform analyses; 
Check the structure; 
Analysis; 
Presentation of the results. 
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8.1 STRUCTURAL SYSTEM 
 
Structural system is Space. Analysis is performed following DIN (EC 2) standards. Structural 
system is entered by: 
 

 

ICON:  Structural system 
MENU: SOFiPLUS →Structural system… 
Command: SOF_GSYSMOD 

 

 
 
In the Data Base Description and Choice dialogue box enter the following database 
parameters: 
 
Project 3D House 
Database House 
Design Code DIN 1045 
Orientation of Self 
Weight: 

Pos. Z axis 
 

Maximum number of 
element per group 

10000 
 

Point size 0.05 
Structural mode Space 
Database coordinate 
system 

SOFiSTiK 
 

Drawing units m 
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8.2 MATERIAL 
 
Slab material is concrete 35. 
 

 

ICON:            Material 
 MENU: SOFiPLUS →Defined model→Material 
Command: SOF_GSYMATE 

 
Enter materials for the inspected structure in the dialogue box. 
 
Standard Concrete C 35 
Standard reinforcing Steel BST 500 
 

 
 
 

8.3 STRUCTURAL LINES 
 
As background for defining mathematical model architectural drawings are used. This drawing 
is utilized to train structural lines. For outward walls structural line passes on 1/3 of the wall 
thickness. 
 

 

  ICON:   1/3 Line 
    MENU:    SOFiPLUS →Defined model→Auxiliary Line→1/3 Line 
  Command: SOF_DRITTEL_LINIE 

 
Firstly click on the inner wall line and then on the outward line. SOFiPLUS draws structural 
line on 1/3 of the inner wall edge. 

 
 
Inner walls are presented with structural lines which pass through center of the wall. 
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    ICON:    Center Line 
   MENU:     SOFiPLUS →Defined model→Auxiliary Line→ Center Line 
    Command: SOF_MITTEL_LINIE 

 
 
Structural lines are placed on layer: X__AUFL 
 

 
 
Beside these lines, several other structural lines are drawn. By using simple AutoCAD 
command Line, draw lines over the contours of the area segments. 
These lines should be placed on layer: X__AUFL. If these lines are not on the stated layer, 
you must change Layer attribute on all lines. 
 

 

    ICON:    Copy to structural Layer 
   MENU:     SOFiPLUS→Defined model→Auxiliary Line→S Copy to            
structural Layer 
    Command: SOF_DRITTEL-LINIE 

 
After selecting this command, click on the auxiliary lines. Lines are now transported on layer: 
X__AUFL and they become structural lines. 
 
 

8.4 STRUCTURAL AREAS 
 
Structural areas are parts of the slab limited with structural lines. At space systems, lines 
should be coplanar. Before defining the areas it is desirable to close all layers except layer 
with the structural lines. After that make control over the components of the structural lines so 
as to eliminate errors (usually contours are not ideally closed) or to select creating areas by 
selecting contour lines which do not require closed contours. 
 

 

    ICON:    Structure area 
   MENU:     SOFiPLUS→Defined model→Structure area 
    Command: SOF_PM_AREA 

 
Execution of the command is combined: by selecting data on the command line: 
  
Select option <Pick point in area>[PICK Point in area /SELECT Boundary/SELECT 
Plane/PICK Structural edge]: 
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and by entering slab attributes in edit boxes in the structural area dialogue box. 
 

 
 
Predefined slab thickness is 18 cm. If this thickness is not adequate it should be changed. 
Current materials are shown in the window. They can be changed using buttons Slab (for 
concrete) and Reinforcement.  
Loads… button starts the process of defining loads for the area which is generated. By first 
start of Loads… Loadcase Manager dialogue box is called up because there are no 
previously defined load cases. In this dialogue box enter all load cases which will be used in 
the slab analysis process, and place the current load case which will be first to define the 
loads. In this example it is 1 Loadcase Dead Load. 
 

 
 
 
 
In Loads and Areas dialogue box enter value for the Dead load 1.5 kN/m  and Imposed load 
3.5 kN/m . 

2

2
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Since loads are entered, click inside closed contour. SOFiPLUS analyzes contour and if 
everything is correctly specified it marks the contour and displays labels for area and loads. 
Structural areas may be generated by clicking point which lies inside area contour or by 
clicking on the boundary lines (SELECT Boundary) namely structural edges (PICK Structural 
edge). 
 
Select option <Pick point in area>[PICK Point in area /SELECT Boundary/SELECT 
Plane/PICK Structural edge]: 
 
If first option is used (Pick point in area), contour which defines structural area has to be 
ideally closed and has to lie in current XY plane. For example, if structural area of one of the 
vertical walls has to be defined, first a change in coordinate system has to be made, so the 
wall should lie in the new XY plane. 
 
 

 
Select option <pick Structural edge>[PICK Point in area/SELECT Boundary/SELECT 
Plane/PICK Structural edge]:   select-p  (defines new drawing plane-xy) 
_3point 
Specify new origin point <0,0,0>: (click on point P1) 
Specify point on positive portion of X-axis <-3.8588,-11.9044,-4.0000>: (click on point P2) 
Specify point on positive-Y portion of the UCS XY plane  
<-4.8588,-10.9044,-4.0000>: (click on point P3) 
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This process continues with entering point which lies inside closed wall contour. If the 
procedure is correctly performed, program itself labels the area displaying the number and 
load values.  
At complex areas second mode for defining structural areas is simpler to use, by selecting the 
structural edges (PICK Structural edge). Before this option takes place, auxiliary lines which 
will be used for defining area contours have to be converted in structural edges. 
 

 

    ICON:    Structure edge 
   MENU:     SOFiPLUS→Defined model→Structure edge 
    Command: SOF_PM_EDGE 

 
Start point (end+cen+nod+int) or [Select entity]:  
(select entities to convert into structural edges) 
 
You should have in mind that selection direction determines direction of local Y-axis. User 
should pay attention on the text shown after creation of the structural area. If text is normal, 
local Z-axis is directional to user. If text is inversed, local Z-axis is in the reversed direction. It 
is eligible to make visualization by showing the directions of the local element axes.  
 
 

8.5 OPENINGS 
 
Definition of the openings at space systems differs from the described definition in line 
systems. 
 

 

    ICON:           Opening 
   MENU:          SOFiPLUS→Defined model→ Opening    
    Command:     SOF_PM_HOLE 

 
At space systems, firstly area in which opening lies is set and hence structural lines which 
define the opening are clicked. 
 
Command: 
Define opening 
structural area: (click on structural area) 
pick structural line (end+cen+int+nea):  
  (click on the first structural line) 
pick structural line (end+cen+int+nea):  
  (click on the second structural line) 
........ 
 
As far as area is correctly defined, program itself marks the area with the text Hole. 
 



 
 
 

 
8-184        SOFiPLUS_Tutorial_IGH.docf 

 

8.6 BEAMS/COLUMNS 
 
In this example, easiest way to enter beams and columns is by modification of structural 
edges. 
 

 

   ICON:    Modify Structural Edges 
  MENU:   SOFiPLUS→Modify model→Structural Edges 
   Command: SOF_ PM_EDGE_M 

 
Select all edges to place rectangular beams. In the dialogue box click on Beam tab. 
 

 
 
With button Cross Section, cross sections of beam elements is created, i.e. cross section of 
the respective beam. In this example two cross sections are defined: rectangular 40/50 cm 
and circular d=40 cm, 
 

 
 
and cross section 1 of beam elements is selected. Similarly columns which lie on area 
boundaries are created. These columns have section no. 2. 
The rest columns are created with command: 
  

 

   ICON: Beam 
  MENU:  SOFiPLUS→Create Finite Elements→Beam 
   Command: SOF_ GSTAB 

 
 
Command: 
Start node (end+mid+cen+nod+qua+int+per+nea):  
 (Enter first node of the column) 
End node (end+mid+cen+nod+qua+int+per+nea): 
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 (Enter second node of the column) 
Rotation of y-axis <0> or [Xx/Yy/Zz/Negx/nEgy/neGz]: 
 (Enter rotational angle of column local y-axes) 
First Beam No.<337>: Return 
Section number<1>: (Enter section number) 
Start node (end+mid+cen+nod+qua+int+per+nea): Return 
 
To simplify this process, only one column may be created and the rest may be copied with 
AutoCAD commands Copy or Array. 
 
NOTICE: When elements are copied (Copy or Array), the program does not enters new 
nodes automatically. Therefore control of the system is necessary.  
 

 
   ICON: Import 
  MENU:  SOFiPLUS→Analysis Data Base (CDB)→Import (.cdb→.dwg) 
   Command: SOF_GENFIN 

 
In the following dialogue box click to check: Check run (no output). As stated before this 
command eliminates errors like node duplication, deletion of nodes which are connected to 
elements and etc. 
 

 
 
 

8.7 BOUNDARY CONDITIONS 
 
As difference from plane structures where by definition area edges are formed as freely 
supported (PZZ), in space structures by definition no limitations of structure are introduced. 
Walls are plane structures which have constrained displacements in the supports along the 
length and height of the wall (local X and Z coordinate). 
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Also, displacements in the points where columns are supported should be constrained. Since 
these nodes are spatial, displacements and rotations in all directions of the supports should 
be constrained. 
 
 

 

   ICON: Modify Structure Point 
  MENU:  SOFiPLUS→Defined model→Modify Column/Structure Point    
   Command: SOF_PM_POINT_M 

 
Select all points of column supports and mark all boxes of prescribed deformations. 
 

 
 

8.8 FINITE ELEMENT MESH (FEM) 
 
The procedure conducted in the previous steps is predefined for automatic finite element 
mesh generation. 
 

 

   ICON: Mesh Generation 
  MENU:  SOFiPLUS→Generate→Automatic mash generation 
   Command: SOF_G_MASHGEN 
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Accept maximum length of element’s edge 0.8 m, and leave the remaining parameters as 
selected by default. 
 

8.9 DATABASE IMPORT 
 
When generation process is finished, finite element mesh is invisible for the user. To display it 
on the screen analysis database should be imported. 
 

 
   ICON: Import 
  MENU:  SOFiPLUS→Analysis Data Base (CDB)→Import (.cdb→.dwg) 
   Command: SOF_GENFIN 
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8.10 STRUCTURE CONTROL 
 
Since mesh is generated, it is advisable to make visual control over the structure. Program 
Animator enables the best visual control of the structure. 
 

 
 
Straightaway user notices that error occurred while modeling the structure. Region over the 
staircase area is molded with finite elements. This region should be empty and the 
neighboring area has to be moulded.   
Also good practice is to check supports. Usually at complex structures, some supports may 
be forgotten or wrong moulded.  
 

 
 
In this case there are no errors in the supports. 
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8.11 CORRECTION OF THE FINITE ELEMENT MESH 
 
In the inspected example, errors are eliminated by deleting the structural area over the 
staircase region (use AutoCAD command Erase) and designing new area in the neighboring 
area. After this corrections, finite element mesh and visual controls should be repeated. You 
should be careful when re-creating the finite element mesh prescribed displacements in 
points on the columns are not remembered and must be set again. 
  

 
 
Correct structure is shown below. 
 

 
 
Usually, in the process for generation structural areas, schedule of edge selection is not taken 
under consideration. As a result, local coordinate systems of area segments may be 
irregularly oriented.  Ordinarily control on the local systems of area elements is made. 
 

 

   ICON: Display Area Elem. Coordinate System 
  MENU:  SOFiPLUS→Visualize→Area Elem. Coordinate System 
   Command: SOF_GQKS 

 
Select the elements to draw coordinate systems. It is enough to select one element from the 
group, because all elements have same orientation. 
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For this example, it is obvious that three areas are oriented in opposite direction to the default 
(Z-axis should be downwards). For these areas on all elements local coordinate system 
should be rotated.  
 

 

   ICON: Rotate Area Element 
  MENU:  SOFiPLUS→Modify Finite Element→Rotate Area Element 
   Command: SOF_GQUADDREH 

 
Select all elements which have to rotate the local coordinate system.  
 

8.12 BASEMENT PLATFORM 
 
First, Auxiliary Lines  will be converted into Structural Edges. All structural edges, except 
edges along the central opening, will be generated as beams with dimensions of cross 
section 40/50 cm. 
 

 

    ICON:    Structure edge 
   MENU:     SOFiPLUS→Defined model→Structure edge 
    Command: SOF_PM_EDGE 

 
Command: SOF_PM_EDGE 
Start point (end+cen+nod+int) or [Select entity]: S 
    (Select all lines which will be converted as beams) 
Select objects: 56 found 
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8.13 STRUCTURAL AREAS 
 
Structural areas will be formed with option Pick Points in Area. 
 

 

    ICON:    Structure area 
   MENU:     SOFiPLUS→Defined model→Structure area 
    Command: SOF_PM_AREA 

  
Select option <Pick point in area>[PICK Point in area /SELECT Boundary/SELECT 
Plane/PICK Structural edge]: PICK-P 
 
To make the creation of the central area much easier, circle opening may be temporary 
eliminated. 

 

8.14 OPENINGS 
 
During defining the opening in the center of the structure, first select the area in which 
opening lies, and then the edge which defines the opening. 
 

 

    ICON:    Opening 
   MENU:     SOFiPLUS→Defined model→ Opening    
    Command: SOF_PM_HOLE 

 
When circular opening was transformed into structural edge, program divides the opening on 
four circle arches. 
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Command: 
Define opening 
structural area: (click on the structural area) 
pick structural line (end+cen+int+nea):  
  (click on the first circular arch) 
pick structural line (end+cen+int+nea):  
  (click on the second circular arch) 
........ 
 
 

8.15 BEAMS/COLUMNS 
 
Beams will be entered by modifying the structural edges. 
 

 

   ICON: Modify Structural Edges 
  MENU:  SOFiPLUS→Modify model→Structural Edges 
   Command: SOF_ SOF_PM_EDGE_M 

 
Select all edges which have to assign rectangular beams along their length. In the dialogue 
box select Beam tab. 
 

 
 
From the list select the appropriate cross section for the beam. 
 

 
 
Columns are created with command: 
 

 

   ICON: Beam 
  MENU:  SOFiPLUS→Create Finite Elements→Beam 
   Command: SOF_ GSTAB 
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Command: 
Start node (end+mid+cen+nod+qua+int+per+nea):  
 (Enter first node of the column) 
End node (end+mid+cen+nod+qua+int+per+nea): 
 (Enter second node of the column) 
Rotation of y-axis <0> or [Xx/Yy/Zz/Negx/nEgy/neGz]: 
 (Enter angle of rotation for the local Y-axis of the column) 
First Beam No.<337>: Return 
Section number<1>: (Enter cross section number) 
Start node (end+mid+cen+nod+qua+int+per+nea): Return 
To simplify the process, only one column may be created and the remaining columns may be 
copied with AutoCAD commands Copy or Array. 
 

 
 

8.16 PERMANENT PLATFORMS 
 
Similarly other characteristic platforms are formed. 

 

8.17 FINITE ELEMENT MESH (FEM) 
 
Since structural areas will be created, finite element mesh is generated. 

 

   ICON: Mesh Generation 
  MENU:  SOFiPLUS→Generate→Automatic mash generation 
   Command: SOF_G_MASHGEN 
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8.18 3D STRUCTURE 
 
In the next steps, each platform is placed on the appropriate location in the structure. 
Therefore, AutoCAD command Move is used. If a platform is repeating in the structure it can 
be copied with Copy command. 
 

 
 

8.19 EXPORTING DATABASE 
 
To save all data related to the drawing in the analysis database, it has to be exported. In 
complex structures it is advisable to control the database before exporting.  
 

 

ICON:     Export 
MENU:   SOFiPLUS→Analyze Data Base (CDB)→Export (.dwg→.cdb) 
Command: SOF_GENFIN 

 



 
 
 

 
8-195        SOFiPLUS_Tutorial_IGH.docf 

 
 

8.20 ANALYSIS OF STRUCTURE 
 
Analysis of the structure is done with WTEDY program. 
 

 

ICON:            Edit (Win Ted) 
MENU: SOFiPLUS→Analysis … 
Command: SOF_G 
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9. SPACE TRUSS - DOME 
 
The space truss creates dome with radius 30 meters. The dome is made from steel tubular 
profiles. The upper part of the dome has opening for illuminating the interior. The roof is made 
from light materials that have no structural meaning. The roof is only for covering the area. It 
receives and transfers loads from self weight, wind, snow and do not participates in force 
distribution.  
 

9.1 AutoCAD DRAWING PREPARATION 
 
Create layer Mesh and use AutoCAD command: 
  
 Draw→Surfaces→3D Surfaces→Dish 
 

 
 
to plot the area of sphere dome. 
 
Command: ai_dish 
Specify center point of dish: 0,0,0 
Specify radius of dish or [Diameter]: 30 
Enter number of longitudinal segments for surface of dish <16>: 20 
Enter number of latitudinal segments for surface of dish <8>: 10 
Command: zoom 
Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window]  
<real time>: e 
 
The dome is rotated upside down, because you will use SOFiSTiK coordinate system in the 
analysis, which has opposite direction of Z-axis than AutoCAD. 



 
 
 

 
9-197        SOFiPLUS_Tutorial_IGH.docf 

 
 
For better description, three view ports are established: 
 
 View→Viewports→3 Viewports →L 
 
Command: -vports 
Enter an option [Save/Restore/Delete/Join/SIngle/?/2/3/4] <3>: 3 
Enter a configuration option [Horizontal/Vertical/Above/Below/Left/Right]  
<Right>: L 
Regenerating model. 
 
The first view is axonometric review, the second view is second projection and the third is first 
structure projection. 
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9.2 STRUCTURAL SYSTEM 
 
Structural system is spatial (Space). Analysis is performed according EuroCode (EC 2). 
Structural system is revived with: 
 

 

ICON:            Structural system 
MENU: SOFiPLUS →Structural system… 
Command: SOF_GSYSMOD 

 

 
 
Appointed parameters for structural system and database are: 
 
Project TrussDome 
Database TRUSSDOME 
Orientation of Self 
Weight: Pos. Z axis 

Design Code DIN    1045 
Maximum number of 
element per group 10000 

Point size 0.05 
Structural mode Space 
Database coordinate 
system SOFiSTiK 

Drawing units m 
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9.3 MATERIAL 
 
The material for the slab is standard structural steel 
 
 

 

ICON:   Material 
 MENU: SOFiPLUS →Defined model→Material 
Command: SOF_GSYMATE 

 
Acquired material is: 
 
Structural Steel ST 37 (DIN 17100) 
 

 
 
 

9.4 CROSS SECTIONS 
 
Two types of cross section are used in the structure: tubular profile D=70/2 mm and D=51/2 
mm. 
 

 

ICON:            Cross Section 
 MENU: SOFiPLUS →Defined model→Cross Section 
Command: SOF_GQUER 
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9.5 FINITE ELEMENT MESH 
 
Two types of finite elements are used in the mathematical model of the structure: truss and 
shell. First, shell element are generated. Finite element mesh density is determined during 
drawing the surface. 
 
Enter number of longitudinal segments for surface of dish <16>: 20  (20 segments along 
the dish lenght) 
Enter number of latitudinal segments for surface of dish <8>: 10 (10 segments in meridian 
direction) 
 
Shell finite element mesh will be created with objects. 
 

 

ICON:            Generate with Objects 
 MENU: SOFiPLUS →Generate→With Objects 
Command: SOF_GNETGEN 

 
Select QUAD Area elements from the dialogue box, and enter 5 in the group number edit box. 
It indicates that all shell elements belong to group 5 i.e. their number starts from 50000 
(5⋅10000 maximum number of elements per group) 
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Select the mesh during drawing the shell. On the following message: 
  

 
 
answer with Yes.  
 
First Element number<50000>: Return 
 
Accept offered number for numeration the first node in the group. Program converts the mesh 
in shell finite elements. Exception is made in the upper part of the dome where mesh 
concludes with triangular elements. 
 
++++ ERROR: Spurious 3-D-Element can not be converted to a QUAD 
 
Opening is positioned in the upper part of the dome and you should not cover it with finite 
elements. 
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9.6 CORRECTION OF FINITE ELEMENT MESH 
 
Let the opening be larger and extend to the first group of finite elements. Opening is enlarged 
by deleting finite elements from the uppermost segment of the shell. Deletion is done with 
simple AutoCAD command Erase. 

 
 
Command: erase 
Select objects:   (Click on point P1) 
Specify opposite corner:  (Click on point P2) 
 

 

 

ICON:   Truss element 
     MENU:        SOFiPLUS→Create finite element→Truss element 
Command:  SOF_GFACH 

 
Truss elements will be created with the command: 
 

 
First, elements on meridian direction are created. 
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Command: 
Node NA (end+mid+cen+nod+int+ins): (Click on point PA) 
Node NE (end+mid+cen+nod+int+ins): (Click on point PE) 
Section number<1> or [Prestress force]: Return 
 (accept proposed number of cross section) 
First Truss beam No.<1>: 
 (accept proposed element start number)  
Node NA (end+mid+cen+nod+int+ins):  
(continue with the next meridian elements) 
Node NE (end+mid+cen+nod+int+ins): 
 
Then, generate horizontal segments, but only in range of one segment. 
 

 
In the end, generate diagonal segment bars. For these bars number of cross section is 2. 
 
Section number<1> or [Prestress force]: 2 
 
 

 
 
With help of the command Array you are able to create truss elements for whole structure. To 
simplify selecting the elements, make invisible all layers, except layer with truss elements 
X00FACH_TRUSSDOME. 
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Activate the command Array and enter the data according the copy of polar mesh and data 
entered in dialogue box.  
 
 

 
 
 
Select already generated truss elements. 
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and perform the copy process.  
 

 
 

9.7 SUPPORTS 
 
Shell is supported on the bottom ring. Nodes in that part have limited displacements in 
direction of all three axes. 
 

 

   ICON:         Modify Node 
  MENU:        SOFiPLUS→Defined model→Modify Node 
   Command: SOF_GKNOTMOD 

 
Select support points. 
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Enter conventional displacements. 
 

 
 
To control the supports, make restraints visualization. 
 

 

   ICON:         Display Restrains 
  MENU:        SOFiPLUS→Visualize→Restrains 
   Command: SOF_GFEST 

 
You can fulfill particular adjustment in appearance of the supports.  
 
Command: SOF_GFEST 
Loading blocks for restraint symbols 
Settings? [Yes/<No>]: Y 
 
In this example, select red color and symbol size of 1.00 m. 
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Supports are displayed on the drawing. 
 

 

 

In certain situations, supports may overload the drawing. To hide the supports, you should 
switch off the layer XV__FEST_TRUSSDOME or use the command: 
  
SOFiPLUS→Visualize→Delete Visualization 
 

 
 

9.8 MODIFICATION OF SHELL ELEMENTS 
 
By definition, you should generate shell elements with default thickness (0.20 m) and material 
(1). In this example, shell elements have no structural meaning. They are inputted only to limit 
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the space and to transfer the load from self weight, wind and snow on structural elements. 
Removing elements from the structure stiffness  can be made on several methods. 
 
Accept small shell thickness, for example 0.01 m. For that purpose modify shell elements. 
 

 

   ICON: Modify Area Element 
  MENU:  SOFiPLUS→Defined model→Modify Node 
   Command: SOF_GKNOTMOD 

 
Select all shell elements and enter new thickness in the dialogue box. 
 

 
 
You should input new material that has small modulus of elasticity. Click on the Slab 
command button in the dialogue box. After that, click on the New button in the Material 
dialogue box to create new material. 
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Declare a name for the new material and click on the button Properties… to enter material 
properties. 

 
 
 
Self weight [kN/m3] 1.5  
 Elastic Modulus [MPa]  10 small value. 
 
During structure analysis make sure not to adjoin stiffness of shell elements in the overall 
structure stiffness. Click to clear check boxes in the dialogue box that belong to the group 
Active parts of element stiffness. 
 

 
 
Also this procedure can be conducted in the TEDY module as additional command in 
PROGRAM ASE. This process will be explained STRUCTURE ANALYSIS chapter. 
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9.9 INFORMATION / MODIFICATION OF STRUCTURAL 
ELEMENTS  

 
INFO/EDIT 
 
With INFO/EDIT command you are able to review main properties of structural elements with 
possibility to modify them if necessary. 
 

 

ICON:            Info/Edit 
 MENU: SOFiPLUS→Info/Edit… 
Command: SOF_GINFO 

 
Select structural element that you want to get information i.e. you want to modify. Dialogue 
box is called up on the screen where all information about selected element are shown. If 
previously selected element belongs to more structural elements, only information about one 
element are shown. 
 

 
 
With the button Help information about the next element, which has mutual edge with 
selected, are shown. By moving forward (Next) or backward (Previous) you can locate 
element you want to review information. 
 
 

9.10 LOADING 
 
Define all load cases. In the example, default loads are accepted: 
 
Roof weight   1.50 kN/m3 
Snow    0.75 kN/m2      
Compression wind  0.40 kN/m2 
Sucking wind   0.20 kN/m2 
Equipment weight  1.00 kN/m’  along contour of the upper ring 
Temperature  30°    
 

 
ICON:            Loadcase Manager 
MENU: SOFiPLUS→Loadcase Manager 
Command: SOF_GLFMOD 

 
Enter load cases with the button New. 
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9.10.1 Dead Load 
 
With Load Manager make the first load case current. Select the first load case and click on 
the Current button. 
In the load case 1 Dead Load, self weight is entered automatically by declaring value 1.00 
(100%) to the factor SW. If in other load cases, you need to enter only percentage of the self 
weight, you can accomplish that by entering proper value for the factor SW. 
The weight of the steel profiles will be derived by multiplying the area with weight on m’. Roof 
structure will be calculated as product in multiplying roof weight (shell element) on m3 and 
height of shell elements.  
 

9.10.2 Wind 1 
 
Acts on the front side of the shell. It is a load that acts in direction of global X-axis and on 
whole element area. Before applying loads on elements, make the second load case current. 
After that, apply the loads that act on area elements. 
 

 

ICON:            Element Loads 
MENU: SOFiPLUS→Create Loads→Element Loads 
Command: SOF_GQLAS 

 
Command: SOF_GQLAS 
Area elements to be loaded 
Select objects: Specify opposite corner: 426 found 
362 were filtered out. 
Select objects: 1 found, 70 total 
Select objects: Return 
 (elements from the front half of the dome are selected) 
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Load type [Load/Mass/Strain/CUrvature/Temperature/Prestress/CReep]: L 
Load [PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PX 
Load value in kN/m²: 0.40 
Load growth in z-direction<0.0000>: Return 
 

9.10.3 Load 2 
 
Make the third load case current and, as done before, apply loads on the rear side of the 
dome, Px with intensity 0.2 kN. 
 
Command: SOF_GQLAS 
Area elements to be loaded 
Select objects: Specify opposite corner: 426 found 
362 were filtered out. 
Select objects: 1 found, 70 total 
Select objects: Return 
 (elements from the rear half of the dome are selected) 

 
Load type [Load/Mass/Strain/CUrvature/Temperature/Prestress/CReep]: L 
Load [PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PX 
Load value in kN/m²: 0.20 
Load growth in z-direction<0.0000>: Return 
 

9.10.4 Snow 
 
Snow is a load that acts vertically on horizontal unit area. Make the fourth load case current. 
Activate aging the command SOF_GQLAS, and select all dome elements and apply force 
PZP with intensity 0.75 kN/m2. 
 
Command: SOF_GQLAS 
Area elements to be loaded 
Select objects: 
 (select all dome elements) 
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Load type [Load/Mass/Strain/CUrvature/Temperature/Prestress/CReep]: L 
Load [PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PZP 
Load value in kN/m²: 0.75 
Load growth in z-direction<0.0000>: Return 
 
NOTE: To simplify selection of elements, it is eligible to hide temporary already created loads. 
It  performed by the command: 
 
 SOFiPLUS→Visualize→Delete Visualization 
 
In the dialogue box, check the &Loads check box and click to select Switch Off. 
 

 
 

9.10.5 Installation 
Forces from installation act as uniformly distributed line load along the length of the 
uppermost dome ring. After you select fifth load case (Mounting), activate the command: 
 

 

ICON:  Boundary Loads 
MENU: SOFiPLUS→Create Loads→Boundary Loads 
Command: SOF_GRLAS 

 
This command requires sequence input of nodes that receive the line load. 
 
Command: SOF_GRLAS 
Start node (end+mid+cen+nod+int+ins):  <Osnap on> 
next node (end+mid+cen+nod+int+ins): 
Select additional intermediate nodes Return 
next node (end+mid+cen+nod+int+ins): 
Select additional intermediate nodes Return 
 (select all nodes from the uppermost ring) 
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Load type [PX/PY/PZ/PXP/PYP/PZP/PS/MX/MY/MZ/M]: PZ 
Load value in kN/m Start: 1.00 
Load value in kN/m End<1.0000>: 
 

9.10.6 Temperature 
Make Load case 6 Temperature current. Activate again the command: 
 

 

ICON:            Element Loads 
MENU: SOFiPLUS→Create Loads→Element Loads 
Command: SOF_GQLAS 

Command: 
Area elements to be loaded 
Select objects:  
 (select all structure elements) 
Load type <Load>[Load/Mass/Strain/CUrvature/Temperature/Prestress/CReep]: T 
Load [TEMP/DT]: TEMP 
Load value in °C<0.7500>: 30 
 
 

9.11 DATABASE EXPORT 
 
Drawing data have to be transferred into analysis database, wherefrom the rest modules will 
get necessary information.  
 

 

ICON:     SOFiPLUS→Export 
MENU:          SOFiPLUS→Analysis Data Base (CDB)→Export(..  
Command:    SOF_GENFOUT 
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9.12 STRUCTURE ANALYSIS 
 
Analysis of the structure is done in  the program WTEDY.  
 

 

ICON:             Edit (Win Ted) 
MENU: SOFiPLUS→Analysis … 
Command: SOF_G 

 
At the first start of this module, a dialogue box is called up where you should enter input file 
name. 
 

 
 
In this example it is the file TRUSSDOME.DAT. After you select the file, working environment 
of the program WTED is shown. Program disposes of large number of functions which control 
the calculation and commit selection and method of viewing the results. By activating this 
working environment, input file is loaded in the editor. This file can be additionally modified in 
order to load certain operations not enclosed with the default options or to change the 
parameters of the default options. 
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In previous chapters, process of turning off the stiffness of the shell elements 
was explained by using small modulus of elasticity or small shell thickness. In 
continuance, this process is explained in module ASE (module for 3D 
structure analysis). Enter the command: 
  

GRP 5 OFF 
 
that turns off elements from the group 5 (shell elements) 
 
+PROG ASE M80   -E urs:1 
SYST PROB LINE  ITER 1 
ECHO FULL NO; ECHO LOAD YES;   ECHO REAC YES 
GRP 5 OFF 
#include $(name).lf 
EIGE 10 LC 101 
END 
 
From the input file, it is obvious that the calculation process can be activated by two program 
modules: ASE and GRAF. The list of default program modules is determined by the selected 
structure model. You can extend the list, or you can remove certain modules that are not in 
analysis interest. 
In the list of modules: 
 

 
 

the sign “+” denotes that a module is included in the analysis. Module can be removed from 
the analysis by changing the sign in “-“ (click on the sign “+”). Thus, user is able to control the 
programs which participate in the calculation. Three separate icons start the calculation 
process: 
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Starts the WinPs module which allows control of the computation process. 

 

 
Starts the calculation immediately. All marked modules will execute. 

 
Only module in which cursor is positioned, will execute.  

 
During the analysis, several text files are created which contents are possible to view by the 
following icons: 
 

 
 

TRUSSDOME.DAT - input file formed by exporting the database and can be modified in 
TEDY.  
TRASSDOME.ERG - file that contains loads and reactions data 

 

TRUSSDOME.Lst 
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TRUSSDOME.PRT- file that contains output files data  

TRUSSDOME.Lsm 

 
 
 

9.13 DISPLAYING NODE/ELEMENT 
 
If during the analysis program displays errors then the messages for those errors are usually 
connected with the node or element where they appear. At large structures with plenty of 
elements and nodes it is very difficult to find directly the needed element/node. The right 
module for that purpose is WinGraf module and its option for displaying elements from the 
structural system. 
 

 

ICON: WinGraf 
MENU:        SOFiPLUS→Graphical output→Graphical output… Command:  

 
For example, if you want to find nodes with the numbers from 750 to 760 from the work area, 
activate Result types: 
 

 
 
or the icon 

 Draw System Variables  
to open the Draw system-definitions dialogue box, wherefrom you should select Definitions of 
elements→Numbers of elements. 
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Click on the option Number from … to …, to enter the range of numbers that you want to 
display. 
 

 
 

9.14 LOAD CONTROL 
 
Load control can be performed in text files, program URSULA or WinGraf and its tools for 
displaying the loads. For example, to display the forces for the load case 2 Wind 1, select the 
option Area Loads in local components from the Result types work area 
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or by clicking on the icon 
 

  Draw loads 
 
to call up the Draw loads dialogue box and select Trussing→Forces→ Area Loads in local 
components. From the combo box Loadcase select 2 Wind 1. Representation is by vectors. 
Representation→Vector 
 

 
 
Results from the appointed options are shown on the following picture. 
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9.15 RESULTS 
 
Results in WinGraf are presented by the command: 
 

 
ICON:   Draw Results 
MENU:          Select→ Draw Results… 

 
or select Results→Trussing→Trussing Normal Forces in the Result types work area. 
 

 
 
Select the load case in the opened dialogue box to display results and the method for 
showing the results. 
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Graphical presentation of the results for the load case 5. Mounting is as shown on the 
following picture: 
 

 
 
 

9.16 VISUAL CONTROL ON THE STRUCTURE AND RESULTS 
 
For quick visual control on the structure and its geometry, you should use the program 
ANIMATOR. 

 
 
In the current example, main interest are truss elements, so it is advisable to hide the shell 
elements in the structure. 
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 Command - Shoot one group, allows to hide the shell elements by clicking on them 
(shell elements belong to special group 5). 

 
 
You can obtain deformations from certain load case, by clicking the load case in the combo 
box which is activated by 
 

 Command -  Choose loadcase 
  
Select the load case in the following dialogue box, the magnitude, animation speed and 
picture rotation speed. 
 

 
 
 
If you select: 
 

  Command - Coloured result, beside deformations, the stress alteration in the 
elements during structure deformation is shown in differed colors. If you click on the icon: 
 
 
animations stops and representation of the structure deformed shape is displayed. 
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To display static values in particular element, use the tool: 
 

   Element info 
 
Click with the target on a element to display information and the forces for the selected 
element are shown in new window. 
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9.17 QUAD ELEMENT LOADING EXAMPLES 

 
9.17.1 ELEMENT LOADS 

 

 

ICON:            Element Loads 
MENU: SOFiPLUS→Create Loads→Element Loads 
Command: SOF_GQLAS 

 
Command: SOF_GQLAS 
Area elements to be loaded 
Select objects: 
Load type <Load>[Load/Mass/Strain/CUrvature/Temperature/Prestress/CReep]: L 
 

9.17.2 Uniformly distributed load in local Z-axis direction  
 
Load <PX>[PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: Pz 
Load value in kN/m²<10.0000>:10.00 
Load growth in z-direction<0.0000>: Return 
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9.17.3 Variable load in local Z-axis direction 
 
Load <PX>[PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: Pz 
Load value in kN/m²<10.0000>:10.00 
Load growth in z-direction<0.0000>:1.00  (100% enlarged) 
 

 
9.17.4 Uniformly distributed load in global X-axis direction - 

projection  

Load <PX>[PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PXP 
 

Load value in kN/m²<10.0000>:10 
Load growth in z-direction<0.0000>:Return 
 

X 
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9.17.5 Variable load in global X-axis direction - element projection  
 
Load <PX>[PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PXP 
Load value in kN/m²<10.0000>:10 
Load growth in z-direction<0.0000>:-1 (100%) 
 

 
 

9.17.6 Uniformly distributed load in global X-axis direction  
 
Load <PX>[PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PXX 
Load value in kN/m²<10.0000>:10 
Load growth in z-direction<0.0000>:Return 

 
 

9.17.7 Variable load in global X-axis direction  
 
Load <PX>[PX/PY/PZ/PXP/PYP/PZP/PXX/PYY/PZZ]: PXX 
Load value in kN/m²<10.0000>:10 
Load growth in z-direction<0.0000>:-1  (100%) 
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ICON:            Free Area Loads 
MENU: SOFiPLUS→Create Loads→ Free Area  
Command: SOF_GBLAS 
 

 
9.17.8 In global X-axis direction  
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Load acts in P1, P2, P3, P4 plane with depth 15 m on all QUAD element groups. 
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Load acts only on QUAD elements from the group 1. 
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. 
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9.18 SHELL ELEMENTS  
9.18.1 VERTICAL LOADING PLANE 
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9.18.2 Load in gravity direction 
Depth of the load is 70 m from the loading plane. 
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9.18.3 Load in global X-axis direction 
Depth of the load is 70 m. 
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Depth of the load is 40 m. 

 
 
 

9.18.4 Trapezoidal load in global X-axis direction 
 

 

 

 
 

 
 



 
 
 

 
9-238        SOFiPLUS_Tutorial_IGH.docf 

 
 
 
 
 
 

9.18.5 INCLINED LOADING PLANE  
 

 
Load acts in local Z-axis direction (perpendicular to the plane) 
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10. Example 5 : Load distribution on building 

Load distribution on floors. 

Load is applied on the upper floor. 

 
 
 
Load acts on 9.0 m depth (by presumption load has to be applied on all floors on 9.0 m depth 
from the surface where load is applied) 
 
 

 
 

Load distribution across floors. 
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